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8031/ M88 FLASH+PSD Design Tutorial

This tutorial takes you step-by-step through the development cycle of a M88x3Fxx based design, from
design entry, to programming the device. The first part of this tutorial shows how a M8813F1x can be used
in conjunction with a handful of other ICs to implement an automatic gain control (AGC) design. The
tutorial also shows how this design would be implemented using a discrete part solution, and Appendix E
summarizes the various benefits of using a M88x3Fxx device over the discrete solution.
The members of the M88 FLASH+PSD family of programmable system devices are Flash-based
peripherals for use with embedded microcontrollers (MCUs), and are In-System-Programmable (ISP).
These PSDs are designed to interface easily with a variety of 8-bit MCUs, and to provide them with
memory, logic, and 1/0O.
Embedded designs are typically bound by cost, size, and power consumption. The market for products
using embedded MCUs is extremely competitive. Time-to-market and quality features-per-dollar define
success. In using a M88 FLASH+PSD device, you will reduce your cost, time-to-market, power
consumption, board space, design complexity, and chip count.
As you read this document, you will learn how the M88 FLASH+PSD can enhance your MCU, and meet
its needs for Flash memory, EEPROM, SRAM, configurable I/O pins, programmable logic (both sequential
and combinatorial), decoded address space, address expansion, backup power, code integrity, code
security, and ISP. All of these features are to be found in one cost-effective M8813F1x device, and allow
the use of a low cost, minimal feature, ROM-less MCU device.
In addition to giving a step-by-step design entry tutorial, this document usefully highlights three aspects of
the M88 FLASH+PSD solution:
— ISP using concurrent memory or JTAG
— Micro = Cell technology
— The logic simulation capabilities of PSDsilosllI
A typical MCU design with Flash memory consists of:
= an MCU
s the main Flash memory
= and

— aboot PROM or SRAM to implement an ISP download to the main Flash memory

— over an UART channel, or some other communication link.
For systems that use SRAM for ISP, the Flash-programming algorithm must first be downloaded to SRAM
and then the MCU executes from SRAM during ISP. Any power interruption or system glitches that occur
will corrupt the system. Therefore, a boot PROM is a necessity for applications that demand high system
reliability. However, a boot PROM adds cost to the system, and is difficult to update once in service. Flash-

based PSDs address these concerns and combine all of the elements necessary to enable the MCU to
download easily to main Flash memory, and boot memory, while in-system.
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The ISP method just described requires MCU patrticipation. The M88 FLASH+PSD also offers another ISP
method, which uses a JTAG interface, and requires no MCU patrticipation. This means that a completely
blank PSD can be soldered into place, and the entire chip can be programmed, in-system, using ST's
JTAG FlashLink cable and PSDsoft development software. This is a powerful new feature of the M88
FLASH+PSD that allows for easy updates in the field.

Typically, adding a peripheral to the MCU memory space involves adding a lot of circuitry to decode the
address lines, to latch the data lines, and to handle the bus timing. If an M88 FLASH+PSD device is used,
the MCU address, data, and control signals are already routed and processed inside the PSD, and so this
hardware overhead is not required.

Micro = Cells take advantage of this, and allow the designer to build logic peripherals inside the PSD in an
efficient and flexible manner. This tutorial compares a PSD Micro = Cell design with an equivalent
functional design using an Altera EPM7064S CPLD device, thereby emphasizing the efficiency of the PSD
approach.

The M88x3Fxx has 16 output Micro = Cells (OMCs) and 24 input Micro = Cells (IMCs). Each Micro < Cell
occupies a memory location in the MCU address space, and is connected to the data bus. The ability to
load the flip-flops in the OMCs, and to read them back, is useful in such applications as loadable counters,
shift registers, and other system logic. The IMCs can latch external inputs, and be read by the
microcontroller. IMCs are also useful when implementing handshake communication logic with an outside
source.

ST provides complete chip-level Verilog-HDL models of all PSD devices for use with the PSDsilosllI
simulator. These models can be used in conjunction with a user-defined stimulus file to simulate the
functionality of the PSD. PSDsiloslII also comes with a Waveform Editor/Viewer and Watch window (for
stepping through the simulation) that are used in conjunction with the stimulus file. Most of the PSD’s
status and control signals, as well as all the user-defined logic in the CPLD, are available for use with the
Waveform Editor/Viewer and the Watch window. Thus, the user can define MCU-level tasks, such as read
and write, that can be used as external chip-level stimuli to the PSD, and the results of the stimuli can be
viewed using the Waveform Editor/Viewer and Watch window of PSDsiloslII.

A new utility is featured in PSDsoft version 5.X. This utility automatically generates ANSI-C code for the
PSD functions, and can be used with the user’s choice of MCU cross-compilers.

Design Example

The design that has been chosen, by way of an example, in Figure 1, is a piece of hardware with closed-
loop Automatic Gain Control (AGC). This has an analog RF receiver section, which has a Programmable
Gain Amplifier (PGA) to control the signal level that is output though an envelope detection circuit. The
PGA gain must be adjusted in real-time to keep a constant signal level at the envelope detection output.
An Analog-to-Digital Converter (ADC) monitors this output. When the AGC function works properly, a
constant signal level is output from the receiver, which can be used by other analog and digital circuitry
for signal processing.
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Figure 1. Block Diagram of Automatic Gain Control Circuit
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The MCU could be used to perform this real-time gain adjustment, but this would leave it with little
execution time for other tasks. It is highly desirable to free up the MCU by off-loading these repetitive tasks
to dedicated hardware. The AGC function can be moved into the state machine, implemented using
programmable logic, as shown in Figure 1.

In this configuration, the MCU first loads the state machine with a desired signal level, and starts it running,
and then gets on with other tasks. Most of the time, the state machine works autonomously, reading the
outputs of the ADC and comparing the measured value with the desired value. The state machine only
needs to interrupt the MCU when the signal has drifted from the desired level. Along with the Interrupt line,
it provides two signals: ‘Trim’ and ‘Boost’. If the signal level from the receiver is too high, the interrupt is
accompanied by ‘Trim’, and the MCU writes the appropriate value to the PGA to decrement the gain.
Likewise, if the signal level is too low, the interrupt from the state machine is accompanied by ‘Boost’.

This tutorial shows how to implement this AGC function two different ways: a discrete IC solution (using
individual IC devices for programmable logic, memory, etc.), as shown in Figure 2, and an integrated PSD
solution, as shown in Figure 3. In addition to the AGC function, other features that have been implemented
include: the Real-Time-Clock (RTC), In-System Programmability (ISP), and miscellaneous 1/O signals.

Please refer to Appendix F for information related to system memory mapping, ISP issues using a UART,
and memory paging considerations.

4
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Figure 2. Block Diagram for the Discrete Solution
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This is an 80C31 MCU application that has a 128K x 8 Flash memory, a 2K x 8 battery-backed SRAM, a
32K x 8 EEPROM, a real-time clock (RTC), an 8-bit analog-to-digital converter (ADC), a JTAG interface,
an EPM7064S ISP CPLD, and an analog receiver circuit (including PGA). In the discrete solution, in Figure
2, four extra IC devices are required. In the M8813F1x solution, in Figure 3, the Flash memory, EEPROM,
SRAM, CPLD, and battery backup circuitry are all combined in the M8813F1x device.

The following notes can be made regarding the discrete solution (Figure 2):

= The 80C31 MCU is using external memory since internal program and data storage is not sufficient.
As a result, Port 0 and Port 1 are sacrificed for address and data.

s The EPM7064SLC84-5 CPLD is needed for address decoding, control logic, implementation of a
paging/segmentation scheme for the Flash memory and EEPROM, and interfacing to the PGA and
ADC. Please refer to Appendix D for the complete design listing for U6.

m  The 29F010 Flash memory contains 128K x 8 bits of program memory. Notice that address lines A14-
A16 are driven by the CPLD to support the additional address space.

s The A128C256 EEPROM contains 32K x 8 bits of boot memory. This allows concurrent programming
of the Flash memory. Address lines A13-A14 are driven by the CPLD to support the additional address
space.

= The DP8572A RTC, programmable Real-time Clock, is used to time-stamp various data received by
the MCU.

s The LH5116-2K x 8 bit SRAM is configured with battery backup protection.

= The generic 8-bit ADC converts the target signal envelope into a digital value. This IC is controlled by
the CPLD.

= The receiver circuit consists of a collection of components, including: a pre-amplifier, a mixer, a local
oscillator (LO), a PGA, and an envelope detector circuit. The circuit takes an RF signal from the
antenna, as input, and outputs the signal envelop.

m  The 7414 inverter with hysteresis (U7B) is used to provide a stable reset signal to the MCU (U1). U7A
is part of the battery backup circuit for the SRAM.

= The generic OPAMP comparator is part of the battery backup circuit for the SRAM. When V- falls
below the battery voltage, the circuit switches over to powering the SRAM from the battery.

The integrated PSD design, in Figure 3, can be compared to the discrete design, in Figure 2. The memory
(U3, U4, and U6), and the battery backup circuit (U9A and U10) of Figure 2 are all incorporated into the
M8813F1x (U2) of Figure 3. Also, all of the functions handled by the CPLD (U2 of Figure 2), are
implemented in the PSD’s CPLD. The I/O pins are individually configured to match the functions
implemented in the original design.

Using JTAG, the entire M8813F1x device can be programmed. Also, the PSD JTAG pins can be
multiplexed with other I/O. These JTAG features are beyond the capabilities of the EPM7064S.

J
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Figure 3. Block Diagram for the Integrated PSD Design
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Matching the Functions to a M8813F1x
The mapping of the functional areas, of the original design, into the M8813F1x are shown in Table 1.
The 80C31, running at 16 MHz, has a tay)y (time between address valid and instruction valid) of 207 ns.
An M8813F1x-15 (the 150 ns part) was selected to meet the 80C31 access time requirement.

Table 1. Discrete Solution Compared to the M8813F1x Solution

Functional Area

Design Example with Discrete
Components

The Matching M8813F1x Function

Memory

128 KByte Flash Memory
32 KByte EEPROM

2 KByte SRAM

Same

Same

Same

Memory
Paging/Segmentation,
and Control

Extra logic to drive the address
lines, output enables, and chip
selects to the Flash and EEPROM

Automatically taken care of internally by the DPLD,
PSD page register, PSD VM register, and prioritized
memory access.

PLD/Control/Demux

Decoder (EPM7064S)
Address latch logic in CPLD
Various registers used to hold data

or control information to be used
by external devices

Use DPLD (Decoding PLD)

Port A in latched address mode (A7-A0)

Use one Output Micro < Cell per bit for each register

110

Latched data inputs and outputs
on CPLD

Combinatorial outputs on CPLD

MCU 1I/O mode feature

same

Supervisory/JTAG

Automatic switch to battery backup

Limited JTAG interface with no

multiplexing of the JTAG port

available, and no JTAG ISP of
memory available

Built-in comparator automatically switches to battery
power when the system voltage drops below the
battery voltage on pin PC2 (Vgtgy)

Utilizes standard JTAG and non-standard extensions
(to speed programming); the JTAG port can be
multiplexed with other I/0, and the memory and logic
within the PSD is ISP via the JTAG port.

J
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THE M88 FLASH+PSD FUNCTIONAL BLOCKS
The M88x3Fxx provides five system-level functional blocks, and allows the user to define and configure
these blocks to meet the design specification.

MCU Bus Interface

The MCU Bus Interface adapts the address, data, and control lines of a particular MCU to the PSD.
Choices include multiplexed or non-multiplexed address/data bus, and the associated control/handshake
signals.

PLDs (Decode for memory and registers, General logic)
The DPLD generates internal chip selects for the M88 FLASH+PSD Flash memory, EEPROM, SRAM,
Control registers and 1/0 Ports, Peripheral I/O mode, and Micro = Cells.

The CPLD implements general logical functions, such as state machines, shift registers, counters, and
combinatorial logic.

Both PLDs are based on Flash memory technology.

I/O Ports

The M88x3Fxx has four I/O ports: Ports A, B, C, and D. These ports have several modes of operation and
may be selected within PSDsoft during design entry, or by MCU firmware at run-time. Modes that are
defined by PSDsoft are implemented with Non-Volatile Memory (NVM) configuration bits that cannot be
altered unless the device is reprogrammed. The remaining available I/O port operational modes are
determined by the MCU writing to PSD control registers. Please see Application Note AN1x55 for more
details.

Memory

The M8813F1x has 128 KBytes of Flash memory, 32 KBytes of EEPROM, and 2 KBytes of battery-backed
SRAM. All of these memories may operate concurrently. That is to say that, while one (or more) type of
memory is being written to, erased or read, the MCU can still be fetching program code from another.

These memory blocks are placed in the system address space using the PSDsoft development software.
The M88 FLASH+PSD also offers some run-time features that can be used to alter the system memory
map on the fly, which is useful for memory paging, and ISP.

JTAG ISC interface

The M88 FLASH+PSD family includes a JTAG channel for In-System Programming (ISP). This ISP
function is an extension of the typical JTAG boundary-scan function. It is an implementation of the JTAG-
ISC (In-System Configuration) specification that is becoming an industry standard. The entire PSD device
may be configured and programmed while soldered to the end product. The PSD can be completely blank
before programming because the JTAG interface needs no assistance from the MCU. ST has enhanced
the standard four-wire IEEE 1149.1 JTAG interface by making available two additional handshake lines to
speed the programming.

The use of the JTAG interface, and the two additional handshake lines, are defined using PSDsoft. Also,
the MCU has some control over the JTAG interface at run-time.

J
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PSDSOFT DEVELOPMENT TOOLS

PSDsoft is ST’s integrated system development software tool, which runs on a PC in the Windows 95 and
Windows NT environments. PSDsoft supports the configuration of the functional blocks, as described in
the previous sections. PSDsoft consists of the following major modules:

s PSDabel

= PSD Configuration

s PSD Fitter

= PSD Simulator

= PSD Programmer

m C Code Generator

The PSDsoft design process for a PSD devices follows the flow shown in Figure 4.

PSDabel

PSDabel has MINC’s HDL ABEL engine at its core (formerly DATA I/O ABEL). The PSDabel environment
provides an editor to create/edit an .abl file that can be used to define chip select logic, general-purpose
logic, and PSD configuration parameters. Template files are provided for many MCU and PSD
combinations. When the ABL file is compiled, logic is synthesized, and files are created and passed on to
the PSDsoft fitting utility.

PSD Configuration

This utility is used to specify the PSD MCU bus interface type, special I/O pin assignments, and particular
internal PSD functions. The output of this module is a .glc configuration file, which is also used by the
PSDsoft Fitter.

PSD Fitter

PSD Fitter has two main functions: the Fitter and the Address Translator. The Fitter accepts input from
PSDabel and PSD Configuration, synthesizes this user logic and configuration, and fits the design to the
PSD silicon. The Address Translator process allows the user to map the MCU firmware from a cross-
compiler (in Intel HEX or S-Record format) into the NVM blocks within the PSD. As a result, the MCU
firmware is merged with the logic and configuration definition of the PSD. The output of the Address
Translator is an .obj file that can be used by a programmer to program the PSD device. This .obj file can
also be used to program an M88 FLASH+PSD using the JTAG FlashLink cable. The .obj file includes chip
configuration information, the PLD fuse-map, and MCU firmware.

PSD Simulator

ST’s version of SIMUCAD's SILOSIII simulation software provides functional chip-level simulation for PSD
devices. PSDsoft automatically creates files for input to the simulator. These files convey relevant design
information to the simulator. As a result, the user only has to create a stimulus file since all of the signals
and node names are taken from the .abl file.

PSD Programmer

PSD Programmer is the interface to the ST MagicProlll®, PSDpro, PEP300, and FlashLink programming
devices. It accepts the .obj file as input, allows viewing and editing of the .obj file, and programs the PSD
device.

C Code Generation
This is a new feature of PSDsoft that automatically generates C code functions and headers for controlling
Flash PSD devices. These functions and headers are ANSI-C compatible. The generated files (.c and .h)

Kﬁ 9/83
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may be edited to suit the particular application, then compiled and linked with the rest of the code.
Afterwards, the linker output of the cross-compiler (usually in Intel HEX or Motorola S-record format) is
merged with the configuration file of the PSD device in the Address Translate utility of PSDsoft.

The functions and headers provided by PSDsoft, cover PSD operations such as:
= Flash memory program and erase algorithms

= EEPROM program algorithms

= 1/O control and definition

= memory management

= power management.

DESIGN FLOW
This section describes the design flow of a project, from the initial entering of the design, in PSDabel, to
the programming of the device, and its simulation.

Figure 4 shows the PSDsoft Design Flow utility. This is the first window to appear after you invoke
PSDsoft. By double clicking on each box, the associated process is initiated. While this is a convenient
method to navigate through the steps, this tutorial shows how to step through the process using menus
and tool-bars since this approach is less obvious. The section, starting on the page after next, takes you
step-by-step through a tutorial design.

Figure 4. PSDsoft Design Flow
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PSDsoft Program Flow
The high level steps for a PSD design are as follows:

1.

Create or open a project, after entry into PSDsoft. If you are creating a new project, specify the project
name, the directory path, device family, part number, and provide a small description of the design if
desired.

Select a design template (project.abl file), and modify this template to fit your design.

3. Use PSDabel to edit, compile, and optimize the project.abl file. Perform ABEL simulation if desired. To

do so, you will need to create the necessary test vectors, and to place them at the end of the PSDabel
file. A successful PSDabel compile operation generates an optimized PLA file (project.it2) for the Fitter.

Configure the PSD device using PSD Configuration. This generates the project.gic file for the Fitter.

5. Fit the design using PSD Fitter. The Fitter’s input files are obtained from PSDabel and PSD

4

Configuration. The Fitter generates the project.fob file that is passed on to the Address Translator. The
Fitter also generates two fuse-map files, project.afu and project.pfu for the Simulator. After a successful
fit, it is possible to skip to step 8 (simulation), if desired, since PSDsiloslll can be used before or after
MCU firmware is merged with the PSD configuration.

Generate the C code, if desired. Edit this C code to suit your particular application. Then, compile and

link it with your other application C code. Your cross-compiler will output an Intel HEX or Motorola S-
record file containing the firmware.

. Perform the address translation. The Address Translator combines the MCU firmware file and the

project.fob file into a project.obj file. This project.obj file includes the MCU firmware, the fuse-map, and
the configuration bits.

Verify the design using PSD Simulator. Chip level simulation is based on the user's Verilog stimulus
file (projectstl) and fuse-map files from the Fitter. You must create the project.stl file. However,
PSDsoft creates files to be used with the simulator that allow you to use the same names that appear
in your project.abl file, and various reserved names.

. Use PSDsoft to download the project.obj file to the MagicProlll®, PSDpro, or FlashLink JTAG

programmer to program the device. A compatible third party programmer can also be used. Contact
ST or a representative near you for a list of compatible programmers.
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M88 FLASH+PSD TUTORIAL EXAMPLE

This section uses the tutorial design example to illustrate the steps involved in implementing the
functionality discussed earlier. The files required, which were generated for the tutorial design, can be
found in the \PSDSOFT\TUTORIAL\TUTOR8XX\TUTOR directory.

At this point, you may wish to start the PSDsoft program, so that you can follow along with the tutorial
example.

Managing the Project

Each new project may have its own working directory, in which all the files generated by PSDsoft can
reside. Once you specify the new project name, PSDsoft passes the working directory and pertinent
information to other functional modules. In the following sections, you will be guided through a full sample
design process, and key windows are displayed to help you follow the example.

1. Start PSDsoft. The PSDsoft dialog box pops up (Figure 5) enquiring whether you want to open an
existing project, or to create a new one. Select “Open an existing project”, and click OK.

Figure 5. PSDsoft Dialog Box

PSDsoft | x|

& Open an existing project
O Create a new project

Al03143

(If you leave PSDsoft without closing the project you were working on, it will automatically reopen when
you next run PSDsoft. If the PSDsoft dialog box does not appear, pull down the Project menu and
select Open Project). Either way, the “Open Project” dialog box appears, as shown in Figure 6.

Figure 6. Open Project Dialog Box

Open Project | x|

Project Mame:

Project Folder: DAPSDSOFT

Template Mame:  <nones

Device Family: |M88><><Y IEI
Part Number: |M881 IRy IZI
Woltage: 4.5-5.5¢

r Description

Cancel |

Al03144
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2. Click on the Browse button, which brings up the “Open” dialog box, as shown in Figure 7. Go to the
\PSDSOFT\TUTORIAL\TUTOR8XX\TUTOR directory, select the tutor8XX.ini file, and click on the
Open button (this closes the “Open” dialog box).

Figure 7. Open Project — Open Dialog Box

Open HE
Laok jr: |a TutarBex EI e %

File name: |Tut0r8>¢<. ini I I Open I

Files of bype: |Prc|jec:t Files [* ini] EI Cancel |
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3. Click on the OK button (this closes the “Open Project” dialog box).

J
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The PSDabel File

For detailed information on PSDabel, and how it relates to the M88 FLASH+PSD, please read the
comments in the file tutor8XX.abl in Appendix A. Also, refer to ST's Application Note AN1171 and the
PSDsoft PSDabel-HDL Reference Manual. For more information on the system memory map for this
tutorial design, see Appendix F. To open the tutor8XX.abl design file, as shown in Figure 8, click on View-
>Design File, and click the “Design Entry” button on the tool bar, or click on “Design Entry” in the design
flow window.

Figure 8. Design File

ESPSDabel Design Entry - CASTPSDSOFATUT ORIALAT utor8xx\ Tutor\ TutorBxx_abl
module TutorSXEX
title '3T M35 FLASH+P3D Tutorial Design File':
/f Deaigned hy: DIan Harris and Mark Rootz
/7 Design date: f-16-95
// Rewv date 9/17/99 m3r, removed node number 102 from jtagsel node declaration
i
// Description: This shows the logic implementation of the sample design in the HSE
i The design highlights the following functionality of the MES:
L * Effective and efficient use of the Input and Cutput Micro<->Cells
i * How to use I/0 pins while the underlying Micro<->Cell is being used for
L other functionality.
i ¥ Use of the W3IIP3D PROPERTY statement to output demultiplexed address b
L and define Input MNicros-:Cells/Output Hicro<->Cells.
i * Multiplexing the JTAG pins with other I/0.
L * How to logieally interface to an S0C31 MCU, BRTC, and an AGC cirecuit.
f4 Convention: The n i= used throughout the file to indicate active low signals.
L MNote that it is not used with the reserved signal names helow.
L o o o o o o o o o o o Bus Interface Signal declarations o o o o o o o o
/f The reserved signal names are automatically assigned to the appropriate pin
|ﬂf The following are inputs from the MCU
4

Al03146

J

14/83




AN1154 - APPLICATION NOTE

Compiling the Tutor Design

To compile the tutor8XX.abl file, take the following steps:

1. Click on the Options menu. This brings up the “Options” dialog box, with the “Compile Options” tab
selected.

2. Click on each of the options, and read the description in the “Description” box to get a feel for what
each option will do. Then set up the options, as shown in Figure 9, with the Standard Listing selected
under “Listing options” and the Retain redundancy box checked. For a better description of the
various options available, please refer to the PSDabel-HDL Reference Manual.

Figure 9. ABEL Compiler Options

QOptions [ x|

Comnpile Options I Optimization Optionz I Simulation Optionz I Fitter Optionz I

Listing options
QO No Listing

O Expanded Listing

Retain redundancy
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3. Select the “Optimization Options” tab, and set up the options, as shown in Figure 10. Use Default
should be the only item selected.
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Figure 10. ABEL Compiler Options — Optimization Options

Options x|
Compile Options | Optimization Options I Simulation Optionz I Fitter Dptionsl

& Use Default

O Feduce by Pin, Auto polarity
(O Reduce by Fin, Fized polarity
O Mo reduction, Merge anly

- Description

Select this option[Quine McCluskey
Feduction] ta invake Espressa’s exact
minimization option.  Thig option il
zometimes produce more complete logic
minimization than by standard Espresso.
Mote that this option may result in
unacceptably long execution times for
medium to large size designs, and
should only be selected if abzalutely
NECESEAlY.

| (] I | Catrcel | | Apply

Al03148

4. Click on the OK button when you have finished setting up the options.
5. Click on Compile->Compile , as shown in Figure 11. Or, click on the “Compile” button on the tool bar.

J
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Figure 11. Compile->Compile
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6. The PSDabel compiler generates an error file—tutor8XX.ERR (even if no errors are present), and
writes to the log file. The compiler also generates a PLA output file, tutor8XX.tt2, which is used by
PSDsoft for fitting, and is optimized, based on the reduction algorithm specified in the “Optimization
Options” under the Options menu.

7. After compilation, you can display the optimized PLD logic equations that will be used by the Fitter by
pulling down the VIEW menu and selecting the Compiled Equations, as shown in Figure 12. This
opens the tutor8XX.eqZ2 file.

Figure 12. View->Compiled Equations
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Simulating Your Design Using ABEL Simulation
You can do a very simplistic functional simulation of the blocks that make up the PLD using the simulator
that is included with PSDabel. It is important to note that only the functions that are generated within the
.abl file can be simulated using test vectors at the end of the file. For chip-level functional simulation, you
must have the version of PSDsoft that includes the PSDsiloslIl simulation software. To use the simulator
that comes with PSDabel, take the following steps:

1. Click on the Options menu, as shown in Figure 13, which brings up the “Options” dialog box.

Figure 13. Options Dialog Box

ﬂ PS5Dsoft - PSDabel Design Entry - C:ASTPSDSOFATUTORIALAT utor8xxA\Tutor\ T utorBxx_ Ist

PSCOzoft Project File View Edit Compile
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b
&

BT

Project: [TutorBxx| Part: [MB313F1Y][10/11/1999)[10:36:03] 2
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2. Click on the “Simulator Options” tab, and set up the window, as shown in Figure 14: under “Format”,
choose Table format. Ensure that the X-value 0 and Z-value 0 are selected in their respective boxes,
and that Brief trace is selected in the “Trace” box. For the “Register” box, select the Register power-
up 0, and make sure that the “Use .TMV file” box is not checked.

3. Click on the OK button to save your changes.

18/83
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Figure 14. ABEL Compiler — Simulation Options
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4. If you select Simulation Results

in the View menu, PSDabel will automatically start the simulation

process, and display the simulation results based on the logic equations and test vectors in the .abil file,

as shown in Figure 15.

J

19/83




AN1154 - APPLICATION NOTE

Figure 15. Simulation Results
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PSDsoft Configuration

The M88 FLASH+PSD has a programmable MCU bus interface, and is able to interface directly to many
microcontrollers. Using PSD Configuration, you can specify how to interface to the MCU you have chosen
for your design. You can also configure functions specific to the PSD device you are using. This tutorial
design is based on the Intel 80C31 microcontroller, which has an 8-bit multiplexed bus with RD, WR, and
PSEN as the control signals, and an active-high level address latch enable (ALE).

To perform the configuration, take the following steps:

1. Pull down the PSDsoft menu in the main PSDsoft window and choose PSD Configuration, click the
“Configuration” button or click on “Device Config” in the “PSDsoft Design Flow” window. A dialog box
opens entitled “The Global Configuration”, as shown in Figure 16. Make sure the “MCU Bus
Configuration” tab is selected.

2. Setup the global configuration as shown in Figure 16. Ensure 8-Bit is selected under “Data Bus Width”,
Mux is selected under “Address/Data Mode”, High is selected under “Address Latch/Strobe Setup”,
the “Enable Chip-Select Input (CSI)” box is not checked, the WR, RD, PSEN is selected under “Control
Setting”, Data Space is selected under “Flash”, and Program Space is checked under “EEPROM".
This arrangement for program and data space allows the MCU to boot from EEPROM in the program
space, and to download to Flash memory in the data space, if needed. Afterwards, the MCU can
override this arrangement if, for example, the Flash memory needs to become part of the program
space. This can be done by the MCU writing the VM register.

g
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Figure 16. MCU Bus Configuration
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3. Click on the “Other Configuration” tab, as shown in Figure 17, and ensure that the Enable Standby
Voltage Input (PC2) box is checked under “Standby Voltage”, Edge is selected under “Mode of
Loading Micro < Cell by MCU”, and all other boxes are unchecked.

J
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Figure 17. Other Configuration
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4. Click on the “JTAG Configuration” tab, as shown in Figure 18, and ensure that none of the boxes are
checked (because checking the boxes would enable the JTAG port to be operational 100% of the time).
Since, in this tutorial, we are multiplexing the JTAG pins with other signal functions, it is desired that
JTAG functions only be operational when the JEN signal is active (see the Figure 3 schematic).
Enter the value ‘ABCDEF12’ in the “User Code” box below. This value will be programmed into your

PSD device. The User Code can be any value you wish (e.g. to identify end product software revisions,
serial numbers, etc.). Up to eight hexadecimal characters may be entered.

J
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Figure 18. JTAG Configuration
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5. Click on the “Sector Protection” tab, as shown in Figure 19, and ensure that none of the boxes are
checked. The appropriate sector box should only be checked if it is desired that the selected sector be
write protected. These bits can be changed, later, through the JTAG port or the device programmer.

J
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Figure 19. Sector Protection
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6. When you are finished with the global configuration settings, click on the OK button. This saves the
configuration. The M88 FLASH+PSD configuration is now completed. If you ever wish to view the
configuration file, first ensure you are in Configuration Mode (see step 1 of this section). Next, pull down
the View menu and select Configuration Report, as shown in Figure 20, and then select File->Print.

24/83

J




AN1154 - APPLICATION NOTE

Figure 20. Configuration Report
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PSD Fitter: Fitting and Address Translation

PSD Fitter consists of the Fitter and the Address Translator. The Fitter accepts input from PSDabel and
PSD Configuration, synthesizes the user logic and configuration, and fits the design to the M88
FLASH+PSD silicon. The Address Translator process allows the user to map the MCU firmware from a
cross-compiler (in Intel HEX or S-Record format) into the NVM blocks within the PSD. As a result, the MCU
firmware is merged with the logic and configuration definition of the PSD. The output of the Address
Translator is the tutor8XX.obj file.

Fitting the Design

The input files to the Fitter are:

m  futor8XX.tt2—PLA file generated by PSDabel.

m  futor8XX.glc-M88 FLASH+PSD configuration file generated by PSD Configuration.
The output files generated by the Fitter are:

m futor8XX.fob—PLD fuse-map and M88 FLASH+PSD configuration file.
n tutor8XX.afu-Generated for use by the Simulator.

n tutor8XX.pfu-Generated for use by the Simulator.

» futor8XX.obj—Object file (PLD and Configuration portion only).

m tutor8XX.frp—Fitter report file.

To Fit a Design:

1. Click on the Options Menu, and select the “Fitter Options” tab to specify one of the four fitting options,
as shown in Figure 21. For the tutorial, choose Keep Current under “Pin Assignment”, and ensure that
the “Enable Product Term Expansion” and “Perform Register Synthesis” boxes are checked.

"7 25/83




AN1154 - APPLICATION NOTE

Figure 21. Fitter Options
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2. Click OK to save the Fitter options. Then, pull down the PSDsoft menu in the PSDsoft window and
choose PSD Fitter, as shown in Figure 22, or click on the “Logic Synthesis and Fitting” box in the
“PSDsoft Design Flow” window.
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Figure 22. PSDsoft->PSD Fitter
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3. Pull down the Fitter menu and choose Fitting, as shown in Figure 23, or click the Fit button on the tool
bar. If you had clicked on the “Logic Synthesis and Fitting” box in the design flow, the Fitter would run
automatically, and this step would not be necessary.

Figure 23. Fitter->Fitting
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4. The Fitter appends to two files: the log file (PSDsoft.log) and the error file (tutor8XX.ERR). Check the
log file for any possible errors. If there are no errors present (there should not be if you did not modify
the tutor8XX.abl file), skip to Step 7.

5. If the fitting is not successful, you may have to view the tutor8XX.eqZ2 file in PSDabel to see which logic
function caused the fitting problem, and to modify the tutor8XX.abl file accordingly. To view the
optimized equation file (tutor8XX.eq2), see step 7 in the section entitled “Compiling the Tutor Design”
on page 15.
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6. Re-compile the modified tutor8XX.abl file. Repeat Steps 3 to 6 until a successful fit has been found.
Re-enter the Fitter program, and proceed to Step 7.

7. Examine the Fitter Report File by pulling down the VIEW menu, as shown in Figure 24. The report file
shows the results of the fitting process, and the pin assignment for the M88x3Fxx. If you want a fitting
other than the one generated, return to the tutor8XX.abl file to change the signal and pin assignments

as appropriate.

Figure 24. View->Fitter Report
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Generating C code

PSDsoft can generate ANSI C code functions and headers for controlling the M88 FLASH+PSD. This is
an optional step. However, it will save you time by implementing low-level PSD driver function and header
files.

The functions and headers are ANSI-C compatible. The .c and .h files that are generated should be edited
to suit your application, then compiled and linked with the rest of your application code, using an MCU
cross-compiler and linker.

The functions and headers that can be generated by PSDsoft include the following operations:
= Flash memory program and erase algorithms

= EEPROM program algorithms

= 1/O control and definition

= memory and power management.

Although C code generation can be performed anytime after a project is opened, we recommend it be
done after you have successfully performed the fit of your design. Once a successful fit is achieved, all pin
functions and PSD configurations are defined, and the C code may be tailored accordingly.

The source C programming files to implement the AGC function for this tutorial have not been provided.
Since this tutorial is meant to cover all aspects of a M88 FLASH+PSD design, though, we cover a
description of how you would use the C code generation utility for your own project.

Take the following steps to generate C code:
1. Pull down the Tools menu in the PSDsoft window and choose Generate C Code, as shown in Figure

574
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25. Alternately, click the “C Code Gen” button in the Design Flow window.

Figure 25. Tools->Generate C Code
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The dialog box should appear, as shown in Figure 26.

Figure 26. C Code Generation — Functions/Headers
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The “Functions/Headers” dialog box has the following sections:

— Device Info: This contains the M88 FLASH+PSD family and part number of the current project.
These values cannot be changed unless this project is closed and a different one is opened.

— Header: This is for specifying the folder in which you would like to place the C header files (.h)
generated by PSDsoft. (Click the Browse button to help in filling in this section). Typically, a folder
in your MCU cross-compiler environment is chosen. You cannot change the name of the headers
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file(s) at this point since these header files may referenced by name within other header files or the
C functions that are also generated by PSDsoft. Once all of the headers and functions are copied
to their designated folders, you may edit the header file names any way you wish, as long as you
change their names in the respective “#include” statements.

Functions: This is for specifying the folder in which you would like to place the C function file (.c).
(Click the Browse button to help in filling in this section). Typically, a folder in your MCU cross-
compiler environment is chosen. This file will contain the functions you specify in the next section.

C Code Selection: Select the categories of C code functions that you would like to integrate into
your C application program. Under “PSD Category” are the major PSD functional groups that are
supported with C code for the PSD device that is used for this project. Under “C Code Coverage” is
a brief list of the individual functions that are available within each category. To select more than
one category, hold the “Ctrl” key while making selections with the left mouse button. Even if more
than one category is selected, though, only one .c file is generated because functions are appended
within the same file.

Description: This offers a description of the functions that are generated if selected in the “C Code
Selection” box. If you double-click on a function within the Description box, the C code that will be
generated is shown, so you can get an idea of what will appear in the sample C file.

2. After you have made your selection, first click Apply, then click OK. In this example, three files will be
written to your folder(s), which are:

— m8813F1.c: the ANSI-C source for all of the selected functions
— m8813F1.h: the ANSI-C header file to define particular PSD registers
— map813F1l.h: the ANSI-C header file to define locations of system memory elements (Flash,

EEPROM, PSD registers, etc.).

The m8813FL1.h file contains define statements for each individual C function within the m8813F1.c file.
Later, edit m8813F1.h, and simply remove the comment delimiters (/) from the define statement for
any C function that you would like to be compiled with the rest of your C source code.

3. Click on the “Coded Examples” tab at the top of the dialog box, as shown in Figure 27.
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Figure 27. C Code Generation — Coded Examples

C Code Generation %]
Functions/Headers | Coded Examples

- Example

Chaoosze falder in which to place examples. [Use Browse]

Folder:  D:APSDSOFTATUTORIALNT uborEse

- Example Selection

PS5O Categom Coded exarmple [main functions headers)
UART downlaad frorn host ta Flash menary
Memory Paging Execute code across several PSD memony pages
140 Implerment & custom shift register with OMCs
Ewaluation hdwr Evaluation board hardware checkout [EBHCTT)
Ewaluation hdwr Ewaluation board hardware checkeout [S0C31]
- Dezcription

In-Sypstem-Frogramming, UART download from host to Flash memom
... Coming 4098 ......

5P allows programming of Flash PSD with code/data while

ingtalled in the end system. This example program utilizes

the microcontraller's UART channel to communicate with a hast
computer. Memony management during the download is accomplizhed
uzing the Flazh PSD internal contral registers and concurrent

MEMOry arays.

This program will execute on the Flazh PSD evaluation boards B

| K | | Cancel | | Apphy |

Al03165

This sheet contains several examples that you may use as a basis for building your own C code

application. These are complete projects (main, functions, and headers) targeted at a particular MCU.

You may copy these files to another folder, to browse them for ideas, or cut and paste sections from

the examples into your own cross-compiler environment. There are three sections:

— Example: To specify the folder in which you would like to place the example project files generated
by PSDsoft. (Click the Browse button, and select a folder, when filling in this section).

— Example Selection: There are several areas for which you may generate C code. Each category
implements a high-level system function, such as memory paging, UART downloads to Flash
memory, etc.

— Description: This describes each of the coded examples in the “Example Section”

Once the C code generated by PSDsoft is integrated into your own C application, and is successfully
compiled and linked by your MCU cross-compiler, you are ready for address translation.

Performing the Address Translation

The Address Translator combines the tutor8XX.fob file with the MCU firmware file(s) generated by your
chosen MCU cross-compiler. Address Translator generates the tutor8XX.obj file that is to be downloaded
to a programmer that is compatible with the M88 FLASH+PSD.

The addresses within in the generated tutor8XX.obj file are special “direct’” addresses — meaningful to a
programming device. They are not “system” addresses, that an MCU would use, or that the DPLD
decodes. That is what is meant by “Address Translate”. It is a translation of “system” addresses that the
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MCU and its compiler/linker knows about, to a set of “direct” addresses that a device programmer knows

about.

To perform the address translation, take the following steps:

1. Pull down the PSDsoft menu, and choose PSD Fitter. Then, pull down the Fitter menu and choose
Address Translate, or select “MCU Code Mapping” in the design flow. The “Address Translation”
dialog box appears, as shown in Figure 28.

Figure 28. Address Translation

Address Translation
Memony . Filz File
Select Memary Select Equations | Address | Address File Mame
Mame Start Stop
Ipdi & swap & 1215 & lald -
Fs0 Hlpdnk lawap & parlk |EIEIEIEI | |3FFF | |common.hex |
parld & a15 &1ald;
Ipdn & la1b & ald;
F51 |=1-EIEIEI | |?FFF | |common.hex |
Ipdn & lparl & lpgr0 & a15
F52 |alaly; EX [BFFF || |page_thex |
Ipdn & lparl & lpgr0 & a15
Fea  |kald |cnnn | |FFFF | |page_D.he:-: |
- | oK
Fiecord Tupe M apping Maode
& Intel Hex Recard O Motorala 5-Record & Direct O Relative Cancel

Al03166

You will notice a warning message from PSDsoft upon entering the Address Translate window. This
warning is a reminder to ensure that you take paging into account when entering the start/stop
addresses and file names.

The Address Translation dialog box has the following sections:

Memory Select Name: This is the name of the PSD memory segment that will be selected when the
associated equation is true.

Memory Select Equations: Each cell shows the equation for the appropriate PSD memory segment.
These are the optimized equations from the PSDabel file. They are displayed for convenience, and
cannot be modified in this window.

File Address Start: This is the first MCU system address, from MCU compiler/linker, that will be
mapped to a PSD memory segment.

File Address Stop: This is the last MCU system address, from MCU compiler/linker, that will be
mapped to a PSD memory segment.

File Name: This is the MCU firmware file that is generated by your MCU Compiler/Linker.
Record Type: The supported formats are Intel HEX or Motorola S-Record.

Mapping Mode: Two modes of mapping are supported, direct and relative. For more information,
please consult the PSDsoft User Manual.

Notice that PSDsoft attempts to fill in the File Start and File Stop Addresses based on your PSDabel
equations. However, if paging is used, as in this tutorial, these file addresses must be handled carefully
since PSDsoft does not know how your MCU cross-compiler and linker handles paging. As we
progress, this process should become clear.
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2. Type in the file names of your MCU linker output in the appropriate places. In this example, five files
are used. (See Appendix F for information on the system memory map and how these files relate.) Four
of the five files are to be programmed into Flash memory on different pages. The remaining file is to be
programmed into the boot area of the EEPROM. The four Flash files are page 0.hex, page_1.hex,
page_2.hex, and common.hex. The file for the EEPROM is boot.hex. Each of these files can contain
up to 32 KBytes of code.

3. Enter the File Start Addresses, File Stop Addresses, and File Names according to Table 2.

Table 2. Mapping the Memory Sectors to Files

Memory Select File Start Address File Stop Address File Name
FSO 0000 3FFF Common.hex
FS1 4000 TFFF Common.hex
FS2 8000 BFFF Page_0.hex
FS3 C000 FFFF Page_0.hex
FS4 8000 BFFF Page_1.hex
FS5 C000 FFFF Page_1.hex
FS6 8000 BFFF Page_2.hex
FS7 C000 FFFF Page_2.hex

EESO 0000 1FFF boot.hex
EES1 2000 3FFF boot.hex
EES2 - - -
EES3 - - -

In this design, a different file name has been used for each of the sections of code in the Flash memory.
This is because of the address space overlap of the segments. This file scheme is used because, even
though these sections of code physically reside on different memory pages, some linkers will place them
in overlapping absolute address space. The method you use depends on your linker. Alternatively, you
can use a single file name across many memory chip selects if your linker automatically appends extra
address bits that represent your paging scheme. You would then, for example, enter 18-bit addresses to
accompany the single file name, which is passed to the Address Translate utility, instead of 16-bit
addresses to accompany several file names.

Optionally, you can specify only the EEPROM contents to be programmed by the device programmer. It
may be desired to load system code into Flash memory while it is in-system, not on a device programmer.
In this case, only information for EESO and EES1 should be entered in the Address Translate utility.

1. Ensure that Direct Mapping is selected in the “Mapping Mode” box.
2. Select Intel Hex Record in the “Record Type” box.

3. Click on OK to perform the address translation. If no errors are indicated, then tutor8XX.obj will be
placed in your project directory.

If your copy of PSDsoft includes the PSDsiloslll simulator, you should simulate and verify your design
before programming the M88 FLASH+PSD. Please see the next section on how to simulate the tutorial
design.
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M88 FLASH+PSD Chip Simulation

PSDsiloslll is ST's version of SIMUCAD's SILOSIII simulator software. It provides chip-level simulation
and design verification using the Verilog Hardware Description Language (Verilog-HDL). Appendix B lists
the stimulus file (tutor8XX.stl) for this tutorial.

Many of the internal nodes on the M88x3Fxx are available for tracing. Descriptions of the signals that can
be traced by the simulator are listed in Appendix C.

PSDsoft generates all but one of the input files required by the simulator. The file that must be created is

the stimulus file (.stl). In the stimulus file, you can use the same names you used in your PSDabel file, and
the predefined ones in Appendix C.

PSDsoft.run File

One of the files generated by PSDsoft for the simulation process is PSDsoft.run, as listed in Figure 29. It
is a command batch file used by PSDsiloslll. For additional information on the PSDsiloslll commands
(those commands that start with !), please refer to PSDsiloslII's on-line help.

Figure 29. PSDsoft.run File

I Reset all

Ifile .sav = Tutor8XX
lcontrol .ext = all
‘timescal e 1ns/0. 1ns
'I'ib d:\psdsoft\psd8.v
“include "tutor8XxX top"
“include "tutor8XxX stl"
endnodul e

In the PSDsoft.run file:

m  “time-scale 1ns/0.1ns” is a compiler directive for defining the delay values for a module

= “1ns” is the unit of measurement for times and delays

= “0.1 ns”is the precision to which the delays are rounded off

= “linclude” is also a compiler directive that allows the entire contents of a Verilog source file to be
included in another file (PSDsoft.run in this case).

Tutor8XX.top is generated by PSDsoft, based on the PSDabel file, and allows you to use of any of the

signal names within the PSDabel file. There are also parameter definitions for high impedance state

signals (Z1 through Z32) in the .top file. Notice how the “endmodule” statement is the last statement in the

PSDsoft.run file. It is there because it complements the “module WSldesign” statement in the .top file.

There is one important thing to note about the included library files: these files look for other files

automatically generated by PSDsoft from the fuse-map file, and have a .afu or .pfu extension. They allow

simulation of the logic, defined in the .abl file, in the stimulus file.

Running the Logic Simulator
1. Review the stimulus file (tutor8XX.stl) listed in Appendix B.

2. Pull down the PSDsoft menu in the main PSDsoft window and select PSD Simulator, or click the
simulator button on the tool bar.

3. The tutor8XX.stlfile is automatically opened in PSDsoft, as shown in Figure 30.

g
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Figure 30. Running the Logic Simulator
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4. Click on LogicSim, as shown in Figure 31, to invoke the PSDsiloslll simulator

Figure 31. LogicSim

M PSDsoft - - CASTPSDSOFATUTORIALAT utor8xs\ TutorA T utorBxx. stl

PSDgoft Propct File Edit iew JES Nl Tool: Window Help

NEFHBEEIE S ER S EE

-CASTPS... =R

.o oovou v oroeflALYTutorBxx i Tutor\ 991011 '2.|J|g

Fums Silos simulator Project: [TutorSx| Par: [ME53 3F1][10/11/1999)[11:03.05] 2
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The following events happen automatically, as a result of clicking on the LogicSim button:

— The PSDsiloslll simulator starts

— The simulator loads the project tutor8XX.spj, PSDsoft.run, and a window displaying the tutor8XX.stl

J

file, as shown in Figure 32.
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Figure 32. Logic Simulator Input
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5. Click on the Go button. This automatically opens an “Output” window for viewing the results of the
simulation, as shown in Figure 33.

Figure 33. Logic Simulator Output
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Running the Analyzer
Now that the logic simulation is complete, the results can be displayed with the PSDsiloslll Data Analyzer
by performing the following steps:

1. Pull down the Window menu and select Data Analyzer, as shown in Figure 34; or press F6, or click
on the appropriate button on the tool bar.

J
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Figure 34. Running the Analyzer
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2. The PSDSiloslll Data Analyzer window appears with the simulation results displayed on screen, as
shown in Figure 35 (but Your screen will look different.). Please see the tutorial on the Data Analyzer
and the Explorer under Help->Contents on how to rearrange and group signals.

Figure 35. Simulation Results
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Working With the Explorer

The Explorer in PSDSiloslll can be used in conjunction with the Data Analyzer to add and trace signals.
To open the explorer, ensure that you have simulated the design by following the steps in the section
entitled “Running the Logic Simulator”, on page 34. Next click on the Window->Open Explorer menu
selection or the Explorer button and the explorer window will appear, as shown in Figure 36. The Explorer
shows all viewable signals.

g
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Figure 36. Explorer
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Signals can be added to the Data Analyzer window using the Explorer by holding the “CTRL" button down,
and clicking on all the signals that you want to add to the Data Analyzer window. Once you have chosen
all the desired signals, right-click on one of the signals, and select Add Signals to Analyzer. Next, click
anywhere in the Data Analyzer window, and the signals you added will appear at the bottom of the window,
as shown in Figure 37.

Figure 37. Adding Signals to the Analyzer
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For more information on the Explorer or Data Analyzer, please see the on-line help, and the PSDsiloslll
User Manual. Also, please refer to this manual for information on how to us the PSDsiloslll Watch Window,
which is beyond the scope of this tutorial.

Programming the M88 FLASH+PSD

The PSD Programmer is the programming interface to the ST MagicProIII®, PSDpro, and FlashLink
programmers. It enables downloading any PSD .obj file; and displays the Flash and EEPROM locations,
the PLD fuse-map, and the configuration bits (ACR). You can also perform the following operations from
the Functions menu:

— Blank Test: to check to see if the device is blank.

— Upload: to upload the contents of the device that were programmed to the buffer.
— Program: to program the device with the .obj file.

— Verify: to verify the programmed device against the .obj file in the buffer.

— FErase: to erase the device completely.

J
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If you have a MagicProlll, PSDpro, or FlashLink device programmer connected to your PC, take the
following steps to program the M88 FLASH+PSD after the design has been compiled and the .obj file has
been generated:

1. Pull down the PSDsoft menu in the main PSDsoft window and choose PSD Programmer, or click the
appropriate button on the tool bar.

2. The tutor813XX.obj file is downloaded and displayed on the screen automatically, as shown in Figure
38.

Figure 38. PSD Programmer
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ooo7o |FF [FF [FF [FF [FF [FF [FF [FF [FF [FF [FF [FF [FF [FF [FF [FF
oooso [P [FF [FF [FF JFF [FF [FF [FF [FF [FF [FF [FF [FF [FF [FF [FF
oooso  |FF [FF [FF [FF [FF [FF [FF [FF [FF [FF [FF [FF [FF [FF [FF [FF
oooao  |FF [FF [FF [FF [FF [FF [FF [FF |FF [FF [FF [FF [FF [FF [FF [FF

For Help. press F1 Project: [TuborGws] Part: [MS513F1Y][10/11/1999[10:36:03] 2
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Assuming you have a MagicProlll programmer installed, to program a device do the following:

1. Pull down the Functions menu and select Program; or click the Program button on the tool bar that
is available when the PSD Programmer is invoked. The “PSD Programmer — Program Confirmation”
dialog box appears, as shown in Figure 39, which enables you to program the Flash, EEPROM or PLD/
ACR (PSD Configuration) regions of the device.

J
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Figure 39. PSD Programmer — Program Confirmation
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2. Select “All”, as shown in Figure 39.

3. Place the PSD device into the programmer, checking that it is correctly orientated, and snap the lid
down on the device carrier. Then, click on the OK button. As programming takes place, the MagicProlll
programmer checks each location, after it is programmed, to make sure it matches the contents in the
.obj file. If a particular location cannot be programmed properly, an error message is shown. If this
occurs, you must restart from the beginning, and program a fully erased and functional part.

PSDpro

If you have a PSDpro connected to one of your PC’s parallel ports, you can select and configure it by going
to the Options menu in the PSD Programmer environment and selecting Hardware Setup, as shown in
Figure 40.

Figure 40. PSD Programmer — Hardware Setup
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Once the “PSD Programmer — Hardware Setup” dialog box appears, select PSDpro, in the “Hardware
Section”, as shown in Figure 41.

J
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Figure 41. PSD Pro
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Next, you will see that the Auto Select option becomes active. This means that PSDsoft will automatically
detect to which PC parallel port your PSDpro is connected. Just click OK, and the PSDpro will be detected
and configured if the connections are good.

The same menu options and capabilities that apply to the MagicProlll in the section above also apply to
the PSDpro.

JTAG: FlashLink
If you have a FlashLink cable installed on one of your PC’s parallel ports, you can select and configure it
as follows:

1. Gotothe Options menu in the PSD Programmer environment, and select Hardware Setup. Once the
“PSD Programmer — Hardware Setup” dialog box appears, select FlashLink, in the “Hardware Section”,
as shown in Figure 42.

Figure 42. FlashLink
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2. Next, you will see that the Auto Select option becomes active, as well as Loop Test, as shown in
Figure 43.

J
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Figure 43. Auto-select and Loop Test
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Auto Select means that PSDsoft will automatically detect to which PC parallel port your FlashLink cable
is connected (even if the other end of the FlashLink cable is not connected to the target system). Just click
OK, and the FlashLink cable will be detected. Optionally, you can return to the Hardware Setup menu to
run a Loop Test on the FlashLink cable. This is a hardware integrity test that requires the loop-back cable
(that is provided) to be installed on the FlashLink cable. (Please see the FlashLink installation manual).

3.

Now connect the FlashLink cable to your target system, and power-on the system. The target system
needs to be powered up since the FlashLink circuitry draws its power from the target.

Set up your JTAG chain (as described in the next section)

Once your JTAG chain has been set up, program your device while it is in-system. (Programming is
accomplished in the “JTAG Chain Setup” window. This is described in the next section.)

Setting up a JTAG Chain
This section takes you step-by-step through the creation of a JTAG Chain File. Since this procedure has
not been finalized, please check our web site (www.st.com) for updates to this document.

The following rules apply for setting up a JTAG chain:

A JTAG chain of one to or more devices must be defined.

All JTAG compatible devices that are connected to the JTAG bus, including the M88 FLASH+PSD and
non-PSD devices from other vendors compose a JTAG chain.

Non-PSD devices that are part of the JTAG chain will be placed, automatically, in bypass mode.

The length of the instruction register, along with a name and device ID must be entered for each non-
PSD device. (In future versions of PSDsoft, you will be able to load this information automatically with
a BSDL file.)

Before programming the PSD device(s), the user must have a valid .obj file for each PSD device in the
chain

Additionally, a Serial Vector Format file, filename.svf, can be created for third party JTAG programming
support.

Please refer to Application Note AN1153 for information in these areas:
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JTAG Spec Compliance
Programming Support
Program/Erase Flow Control
SVF/BSDL file information
Enhanced ISP functions
Multiplexed JTAG pin functions
Dedicated JTAG pin functions
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— ST JTAG ISP connector
— JTAG Chaining

Now, let’s step through a sample JTAG chain setup, and create a JTAG chain file (.jcf).

1. Under JTAG menu, select JTAG Chain Setup, as shown in Figure 44, or click “JTAG Prog” in the
design flow.

Figure 44. JTAG Chain Setup
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This opens the “JTAG Chain Setup” dialog box, as shown in Figure 45.

Figure 45. JTAG Chain Setup Dialog Box
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2. In the “Chain Information” box, click Browse. This brings up the “Open” window, as shown in Figure

46. Select the Tutor8XX.objfile in the \PSDSOFT\TUTORIAL\TUTOR8XX\TUTOR\ directory, and click
Open.

J
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Figure 46. JTAG Chain Setup — Open Window
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Your “JTAG Chain Setup” window should now appear as shown in Figure 47.
Figure 47. JTAG Chain Setup Window
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ﬂl Device Mames I File Marnes I Operation |
Add
[ 1+ I Move IEIITl
L]
L]
[ LogMode Create SWF... | | Reset | Go |
Al03185

If the device name (M8813F1x in this case) does not automatically appear in the “Device Name”

window, select the appropriate device.

3. Click the Add button. Your “JTAG Chain Setup” window should appear as shown in Figure 48.

44/83

J




AN1154 - APPLICATION NOTE

Figure 48. JTAG Chain Setup Window — After an Add

JTAG Chain Setup

~ITAG Chain File
File: M.ame: I | | Browse. .. |
Cancel |
- Chain [nformation
File: M.ame: |D:\PSDSDFT'\TUTDFHAL\Tutoerx\TutorWl | Browmsze... |
Device Mame |M88‘|3F1X IE"
#I Device Mames I File Hames I O peration |
1 MAs3Fx CAPSDSOFTHTUTORIALATubarBy...  ByPass
Add
[l o [hee 15
L]
[ LogMode Create SWF... | | Feset | | Go |

Al03186

4. Right -click anywhere on the line that just appeared (line 1), and select Properties , as shown in Figure
49.

J
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Figure 49. JTAG Chain Setup Window — Selecting Properties

JTAG Chain Setup
T4 Chain File

File: Mame: I

|| Browse... |

Cancel

[ x|
[ Concel ]

- Chait [nformation

File: Mame: |D:\PSDSDFT'\TUTDHIAL\Tutoerx\TutorWl| Browsze... |

Device Mame IMSS‘I I E"
] Device Mames File: M armes Operation
Properties. ..
Blank Test
Erase
Program

[l

o 1 e B
ploa

v ByPass

O Log Mode

Create SWF... | | Feset

Al03187

5. This opens the “JTAG Chain Setup Properties” dialog box. Ensure that the “Set Pins/Flow Control” tab
is selected, and set up the window with the following selections (based on Figure 3 of this tutorial). The
proper selections are shown in Figure 50. Under “Flow Control”, select Option 3. In the “Set Pins” box,

set up the ports as follows:

they are.

46/83

Port A: set all the pins to “OUTPUT LOW (CMOS)”
Port B: set pins pb7 to pb3 to “INPUT (HI-Z)", and pins pb2 to pb0 to “OUTPUT LOW CMQS)”
Port C: change pc3 to “TSTAT (CMOS)”, and pc4 to “TERR (CMQOS)". Leave the rest of the pins as

Port D: set pins pd1 and pdO to “INPUT (HI-Z)", and pd2 to “OUTPUT HIGH (CMOS)”

J
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Figure 50. JTAG Chain Setup Properties

JTAG Chain Setup Properties x|
Set Fing/Flow Cortiel | JTAG Attibutes | User Code |
- Flows Control
Select the data handshake method during JTAG
O Option 1
O Option 2
® Option 3
|- Description
- Set Ping
Select the function of the PSD part ping during JTAG
PORT & PORT B
FEA4 3210 FER4 3210
Joaaagao INPUT HI-Z] jolo o oloelele)
GEEEEAEE® OoUuTPUTLOW [EMOS) QO aCoaEe
(e aloe OUTPUT LOW [OPEM DRAIN) [{QQIOC
JaaaQgQQ OUTRFUT HIGH [CMOS) |00 adao
PORT C FORT D
FEAR4 3210 210
O \elao IMFUT [HI-Z) lelcio
J [ale OUTPUT LOW [CMO%5) QQ0
QT T [T|T|OUTPUT LOW [OPEN DRAIN)
Qoo |CM OUTPUT HIGH [CMO5) =0
ol @ [k|s TSTAT [CMOS)
o TSTAT [OFEN DRAIM]
[o| TERR [CMOS)
(& TERF [OFEM DRAIN]
| QK I | Cancel | | Apply |
Al03188

6. Click on the Apply button (which saves the information you have entered, so far, and greys the “Apply”
button out). Then, click on the “JTAG Attributes” tab. Your “JTAG Chain Setup Properties” window
should now appear as shown in Figure 51.
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Figure 51. JTAG Chain Setup Properties — JTAG Attributes

JTAG Chain Setup Properties B
Set Ping/Flow Contral | JTAG Attibutes | Uzer Code

- TAG Attribut

Device Mame IF'SDS'I 3F1 |

Ingtruction Register Length: |5 |

[0 JTAG Device I0: IDBDEDDD‘I |
JTAG Devices:
< Others ]
FS0E13F1 —
PSDE1F2 Al [ Dol |
- Description

| ok | | Cancel | | Apply |

Al03189

The “Device Name”, “Instruction Register Length:”, and “JTAG Device ID:” are all greyed out because
this information is automatically entered whenever you select a M88x3Fxx device. If you want to enter
information about a non-PSD device, which is to be included in your chain, here is the place to do it. If
you add another device, you need to enter valid information in the “JTAG Attributes” section. Also, note
that if you select the “JTAG Device ID” box, PSDsoft verifies the JTAG ID before programming or
erasing the device.

7. Click on the “User Code” tab, to give the display shown in Figure 52. If you enter a value in the “User
Code” box, the value is compared with the User Code already programmed into the device before any
JTAG operation occurs (e.g. Erase, Program, etc.). If you leave this area blank, no comparison is
performed. Enter ABCDEF12 in the “User Code” box. Then press Apply (which greys the “Apply”
button out), and finally press OK.

J
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Figure 52. JTAG Chain Setup Properties — User Code

JTAG Chain Setup Properties

[[Set Pins/Flow Cortrol | JTAG Attibutes | User Cade |

- User Code

|ABEDEF121

- D escription

[oc ]|

Cancel | |

Apply

Al03190

8. Now, you should be back to the “JTAG Chain Setup” window. Right click on the same line as you did
in step 4, only this time, choose Erase, as shown in Figure 53.

J
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Figure 53. JTAG Chain Setup Erase

JTAG Chain Setup

[ x]
- JTAG Chain Fil

File: Marne: I || Browsze... |

Cancel

- Chain Information
File: M ame: |D:\PSDSDFT\TLITDHIAL\TUIUISHH\TUMW' | Browse. .. |

Device MWame |M8813F1>< JE"

Device Mames Filz Mames

TUTO L
Froperties. ..
Add
Blank Test
Program
“arify I IEl
14
Ll Upload L —H
¥ ByPass [
L]
[ Log Made [ceaesvi.] [ Reet | | Ge ]

Al03191

9. You should now see the “Operation: Erase” dialog box, as shown in Figure 54. Ensure that All is
checked under the “Regions” block, and click OK.

Figure 54. Operation Erase

Operation: Erase H

Fegions:
all
O Flash
B onon
O PLDAACR
O Uszer Code
~ D escription:

Al03192

10.Your “JTAG Chain Setup” window should now appear as shown in Figure 55. Click Go to start the
exchange on the FlashLink cable. If the “Log Mode” box is checked, the JTAG communication status
will appear in the PSDsoft log window, and in the file tutor8XX.log. Turning on the Log Mode feature
will slow down the JTAG communications.

574
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Figure 55. JTAG Chain Setup — After the Erase

JTAG Chain Setup [ x|
~JTAG Chain Fil
File M ame: I | | Browse... |
Cancel |
- Chain Information
File: Manne: |D:\F'SDSDFT\TUTDHIAL\Tutoerx\TutorWl | Browse... |
Device Name |M88‘|3F1>< E|
] Device Mames File Mames O peration
Add

Delete

1[+] I M ove IEIF'

[

Reset | | Go |

O Loatode | Create SYF... |

Al03193

11.After the erase has completed (as indicated in the log window), right click on the same line as in step
4, and choose Program . Select Ok when the window, as shown in Figure 56, appears.

Figure 56. Operation Program

Operation: Program [ x|

Regions:
All

O Flazh
0 eceRow

[ FLDACR
[ User Code

- D'escription:

Al03194

Your “JTAG Chain Setup” should now appear as shown in Figure 57. Select Go, and the PSD will be
programmed with the information in the tutor8XX.obj file.
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Figure 57. JTAG Chain Setup — After Program

JTAG Chain Setup

[ X]
- JTAG Chain File

File M ame: I || Bronwze. . |

Cancel

- Chain Information
File: Marme: |D:\F'SDSDFT\TUTDHI.&L\TutDerx\TutDIWl | Browse... |

Device Mame IMBEH IFIK E||

#] Device Names File Mames Dperation

Add

ol 1+ I Move IElm

L

|

[ Log Mode | Create SVF... | | Reset | | Lo |

AlO3184

12.After you have programmed the device, click Reset at the bottom of the window. This resets the target
circuit board that is connected to the FlashLink cable. This is needed after the Flashlink programs the

PSD because the MCU will have lost its “mind” at this point.
13.Click on the Save button, to save your work in a JTAG Chain File for future use. This action brings up
the “Save As” dialog box, as shown in Figure 58. Type “tutor8xx” in the “File name” box, and click Save.

The file tutor8xx.jcf will be created.

Figure 58. JTAG Chain Setup — Save

Save As HE

Save in I-_j TutorSsx

File hame: |tutor8m¢ | | Save I

Save as lype: IChain Files [%jcf) JZI|

Al03195

14.Now, the “JTAG Chain Setup” window should appear as shown in Figure 59.

J
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Figure 59. JTAG Chain Setup — After the Save

JTAG Chain Setup

~JTAG Chain File
File: Mame: ID:'\F'SDSDFT\TUTDFlIAL'\TutorSm‘\tutorS:-m.j || Browse... |
Cancel |
- Chain Information
File: Marme: |D:\F'SDSDFT\TUTDHI.&L\TutDerx\TutDIWl | Browse... |
Device Mame |M8813F‘I>< B|
#] Device Names File Mames Dperation
Add
[l o [Hee 15
O LogMode | Create SVF... | | Reset | | Go |
Al03196

15.1f you need to load this .jcf file in the future, you will have to click on the Browse button, which will bring
up the “Open” dialog box, as shown in Figure 60. Choose the tutor8xx.jcffile, and click Open.

Figure 60. JTAG Chain Setup — Open Dialog Box

Open HE

Loak, jre I@ TutorSwx IZIl %

File narme: |tut0[8m4. jcf I I Open I

Files of type:  [Chain Files [~icf [ Cancel |

Al03197

Lastly, before leaving the “JTAG Chain Setup” window, you may wish to create a Serial Vector Format
(.svf) file for use with a third-party programmer. To do so, click the Create SVF button, and Browse

through your directory tree to find a place where you want to place the .svf file.

53/83

J




AN1154 - APPLICATION NOTE

ISP AND THE M88 FLASH+PSD

The M88 FLASH+PSD may be programmed in-system, with or without participation from the MCU. For
ISP with the MCU, please see Appendix F for UART download information and considerations. For ISP
without MCU participation, see the Section entitled “JTAG: FlashLink" on page 41. For FlashLink JTAG
programming within the PSDsoft environment please see the application note, AN1153.

REFERENCES
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M88 FLASH+PSD Family Data Sheet

Application Note AN1153 for detailed use of the JTAG channel

Application Note AN1171 for details on the CPLD and I/O pins

Application Note AN1176 for a design guide for the 68HC11 and M8813F1x.
Application Note AN1177 for a design guide for the 80C51XA and M8813F2x.
Application Note AN1178 for a design guide for the 80C51 and M8813F2x.
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APPENDIX A: ABEL DESIGN FILE “ TUTOR8BXX.ABL”
nmodul e Tut or 8XX

title "8XX Tutorial Design File’;

/1 Designed by:Dan Harris and Mark Rootz

/1 Design date:6-16-98

/1 Description:This shows the | ogic inplenmentation of the sanpl e designin the 8XX
Tutorial .

/1 The design highlights the followi ng functionality of the M8x3Fxx:

/1 * Effective and efficient use of the Input and Qutput Mcro<->Cells

/1 * How to use I/O pins while the underlying Mcro<->Cell is being used for
/1 other functionality.

/1 * Use of the WBI PSD PROPERTY st atenent to output denul tipl exed address bits,
/1 and define Input Mcro<->Cells/Qutput Mcro<->Cells.

/1 * Multiplexing the JTAG pins with other I/Q

/1 * Howto logically interface to an 80C31 MCU, RTC, and an AGC circuit.
/1 Revision:1.0

/'l Rev Date:9-21-98

/1 Convention: The n is used throughout the file to indicate active | ow signals.
/1 Note that it is not used with the reserved signal names bel ow

Phrkkxkkkkkkkkkxkkkkkkkkkxkxxx  Bus Interface signal declarations
R R I b S S I O O R R

/1 The reserved signal names are autonatically assigned to the appropriate pin
[/l The following are inputs fromthe MU

w  pin; "CNTLO Input:(pin 47)- wite strobe

rd pin; "CNTL1 Input:(pin 50)- read strobe

psen pin; "CNTL2 I nput:(pin 49)- programstore enabl e

ale pin; "PDO Input:(pin 10)- address |atch enabl e

reset pin;"lnput:(pin 48)- systemreset

al5..a0 pin;"lnput:(pins 46..39,37..30)- denuxed address

LLIE R R R I I R Port A B C D pl n decl ar athﬂ
khkkkkkhkhkkhkkhkhkhkdhkxhkdrkxdhkxkxk*k

[/l Port AI/O

/1 Control outputs are MCU I/ O node out puts

Control 0.. Control 2pin 23, 22, 21;"Some generic control signals

/1 Assign the | atched/demultiplexed address to Port A pins pa4 to paO.
W5l PSD PROPERTY ' Address_Qut Aout[4:0]:Addr_Qut[4:0]";

// Port B1/0O
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PGA Din2. . PGA DnOpin 5, 6, 7;"Data bits used to programthe PGA
"I nplenented with MU I/ O node
Measur ed_Level 3. . Measured_Level O pin istype "reg’ ;" Upper 4 bits of the AAD
converter (ADQC)
W5l PSD PROPERTY '’ DataBus_| MC D[ 7: 4] : Measured_Level [ 3: 0] PortB';

/[l Port CI/0O

/1 Note that pins pcO, pcl, and pc5-6 are nultipl exed output/JTAG signals. pc3
pc4, and pc6

I/ are JTAG signals that are not nultiplexed.

/1 Ensure that under "d obal Configuration" with the "JTAG Configuration" tab
sel ected that none

/1 of the boxes enabling various JTAG signals on certain pins are checked because
the device

/1 will expect only valid JTAG signals on these pins, and no nul tiplexing can be
done under these

/'l circunstances.

/1 Pin pc2 (pin 18) is used for VSTBY (set in global configuration)

Intrn pin 20;"Interrupt the MCU when the gain needs to be changed/ JTAG TNVS
Start_Convpin 19;"Start Conversion signal for the ADC JTAG TCK

Trim pin 17;"The gain is too high and needs to be decrenented/ JTAG TSTAT

Boost pin 14;"There is not enough gain--increnent it/JTAG TERRn

JCEn pin 11;"JTAG chip enabl e signal used to denmultiplex Port C output and JTAG
/0

// Port DI/O

/1 pdO (pin 10) is assigned above to the ALE signal fromthe microcontroller.

/1 Any external chip selects that are generated by decodi ng an address shoul d be
pl aced on

/1 Port D when possible to save as many resources as possi bl e.

RTCcsnpin 8;"Real Tine O ock (RTC) chip select/JTAG TDO

clkin pin;"Port D pin pdl (pin 9) System clock

[/ Qutput Mcro<->Cell assignnents
WSl PSD PROPERTY ' Dat aBus_OMC D[ 7: 4] : Desired_Level [ 3: 0] MCELLAB
W5l PSD PROPERTY ' Dat aBus_OMC Dr7: begi n_cycl e MCELLBC ;

ALEE R S I R S S b b I I I I O I Internal node deCl aratlons
khkkkkhkkhkkhkkhkhkhkhkhkhhkhkhkhkhkhkkhkhkkhkhk*k

nxor d3 node;"This signal is needed to save product terns

neqd node; " True when the neasured signal equals the desired signal |eve
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begi n_cycle node istype 'reg ;"This signal takes the state machine out of idle
STATEL. . STATEO node istype 'reg ;"State machine bits
Desired_Level 3. . Desired_Level 0 node istype 'reg’ ;" The desired gain |evel

fs7..fs0 node;"Min Flash menory segnents

ees3. . eesOnode; "EEPROM nenory segnents

/] Reserved node nanes

rso node; " Sel ect for the SRAM nenory space

csiop node; "Control register

jtagsel node 102;"This is the JTAG enable product term It is used to enable
"the JTAG port signals.

pgrl..pgrO0 node;"Internal PSD Page Register bits

/1 The foll owi ng page regi ster bit definitions are an exanpl e of howto nmani pul ate
nmenory to
[/ facilitate I SP. This scheme is explained in Appendi x F of Application note 57.

swapnode 117;" This page register bit (pgr7) will be used for swappi ng
" nenory segnents after a firmware downl oad fromthe 8031

UART port has conpleted. Wien swap = 0, the secondary

NVM occupi es boot area for ISP, swap = 1, prinmary NVM

occupi es boot area.

enabl e_data_hal f node 116;
" This page register bit (pgr6) will be used to nanipul ate
" the EEPROM The use of this bit is one way to divide the
" EEPROMin into two equal sections, one for boot and one for
" general data. Wen this bit=0, the boot section is active.
" When this bit = 1, the data section is active.

Mhkkkkddkdhxhdrxddxk drx*x*x**xx%x EFI NI TIO\IS R R I R IR R I R I

DLEVEL [Desired Level 3..Desired _Level 0] ;"Desired gain | evel set by MCU

M_EVEL [ Measur ed_Level 3. . Measured_Level 0] ; "Measured gain | evel |atched by | Mcs
STATE_MACH NE = [ STATEL. . STATEOQ] ;

X = .x.;"Don't care synbol

C = .c.;"dock synbol

page = [pgrl, pgrO];

address = [al5..a0];"De-nuxed mcrocontroll er address signals
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EQUATI ONS

LU SR R R R O O b S kS S S I 1 kkhkkkkhkkkhhkkkhhkkkhkkkhkkikk*kkk,*k*%x
DPLD equati ons

/] Generate active high chip selects for the main Fl ash segnents. Each segnent is

16K byt es

/1 for the MB8x3Fxx devi ces.

fsO = ((address >= ~h8000) & (address <= "hBFFF) & (page == 3) & !swap)
# ((address >= ~h0000) & (address <= "h3FFF) & (page == X) & swap);

fsl = (address >= ~h4000) & (address <= "h7FFF) & (page == X);

fs2 = (address >= ~h8000) & (address <= "hBFFF) & (page == 0);

fs3 = (address >= "hQ000) & (address <= “hFFFF) & (page == 0);

fs4 = (address >= ~h8000) & (address <= "hBFFF) & (page == 1);

fs5 = (address >= "hQ000) & (address <= “hFFFF) & (page == 1);

fs6 = (address >= ~h8000) & (address <= "hBFFF) & (page == 2);

fs7 = (address >= "hQ000) & (address <= “hFFFF) & (page == 2);

/'l Generate active high chip selects for the EEPROM segrments. Each segment is 8K

bytes for

/1 the MB813F1x devi ces.

eesO = ((address >= "h0000) & (address <= "h1lFFF) & (page == X) & !swap)
# ((address >= "h8000) & (address <= "h9FFF) & (page == X) & swap &

lenabl e_data_hal f);

eesl = ((address >= "h2000) & (address <= "h3FFF) & (page == X) & !swap)
# ((address >= "hA000) & (address <= "hBFFF) & (page == X) & swap &

lenabl e_data_hal f);

ees?2 = (address >= "h@000) & (address <= "hDFFF) & (page == X) & swap &

enabl e_data_hal f;

ees3 = (address >= "hEOOO) & (address <= "hFFFF) & (page == X) & swap &

enabl e_data_hal f;

// Generate active high chip select for the PSD SRAM (2K bytes).
rs0 = (address >= ~h0100) & (address <= “h08FF) & (page ==

/'l Cenerate active high chip select for the PSD control registers. 256 conti guous
bytes nust be

/| decoded for all M8x3Fxx devi ces.

csiop = (address >= "h0900) & (address <= “h09FF) & (page ==

/] Enable the JTAG port when the JTAG Chip Enable (JCEn) Signal is active

J
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jtagsel = !JCEn;

LR SR EEEEEEEEEEEEEEEEEEEE RS GDLU ECSPLD equatl ons

LR R R R R R R R R R R R R R R R R R R R

/1 1 MPORTANT NOTE: Comment these next four equations out for the ABEL sinmul ation
only. The

/1 PSDsil osl Il Sinulator requires the equations (and they are functionally
/1 correct). The problemis that the MCU presets (loads) and cl ears these
I registers, and the value is not registered through the D input. However
/1 the ABEL sinul ator does not reconi ze any "dot" extentions (As these woul d
/1 normal |y be set up through equations). The basic functionality can stil
/1 be properly tested, but howit is actually inplenented in hardware is
/1 slightly different.

/1 So, if you intend to use the ABEL Sinmul ator, comrent out the follow ng
/1 four lines so that the test vectors at the end of the file will work

/1 properly.

DLEVEL. ck = O;

DLEVEL : = 0O;

begi n_cycle.ck = 0;
begi n_cycle : = 0;

nmxord3 = Measured_Level 3 $ ! Desired_Level 3;

/1 Trimthe gain when the Measured signal level is greater than the desired signa
| evel

/1 Trim= MEVEL > DLEVEL
Trim= (Measured_Level 3 & !Desired_Level 3)
# ((Measured_Level 2 & !Desired_Level 2) & mxord3)

# ((Measured Levell & !'Desired Levell) & nmxord3 & (Measured Level 2 $
I Desired_Level 2))

# ((Measured Level 0 & !Desired Level 0) & nmxord3 & (Measured Level 2 $
| Desired_Level 2)

& (Measured_Level 1 $ !Desired_Level1));
/1 Boost the gain when the Measured signal level is |less than the desired one.
nmeqd = (MLEVEL == DLEVEL);
Boost = Ineqd & ! Trim

/1 Generate the chip sel ect
I'RTCcsn = ((address >= *h0a00) & (address <= “hOaff));

/1 Loading of the various registers
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MLEVEL. | d = !clkin;

/1 State machi ne which controls the conversion start of the ADC, the interrupt to
the MCU,

/1 and the strobing of the I MCs

STATE_NMACHI NE. ck
STATE_NMACH NE. re

cl kin;
lreset;

st at e_di agr am STATE_NACH NE;

state O:
Start _Conv = O;
Intrn = 1;
if (begin_cycle == 1) then 1 el se 0;
state 1:
Start_Conv
goto 2;
state 2:
Start_Conv
goto 3;
state 3:
'Intrn = Trim# Boost; "Interrupt when Measured not equal to Desired
goto O;

1;

1
e

Test _Vectors

/] Test the state machine, trim and boost signals
([cl kin, reset, begin_cycle, MEVEL, DLEVEL] ->
[Start_Conv, Intrn, STATEl, STATEO, Trim Boost])

[ X 0, X *h3, "h4 ] -> X X X X 0, 1];"systemin reset

[ 0, 1, X ~h4, "h4] ->[ O, 1, O, O, O, O ];"systemnot in reset

[ C 1, 1, ~h5, ~h4] ->[ 1, 1, 0, 1, 1, 0 ];

[ C 1, 1, ~h5, "h4] ->[ 0, 1, 1, 0, 1, 0 ];

[ C 1, 1, ~h5, ~h4] ->[ 0, 0, 1, 1, 1, 0];

[ C 1, 1, *h4, *h4] ->] O, 1, 0, O, O, 0 ];

[ C 1, 0, *h4, *h4] ->] O, 1, O, O, O, 0];

end
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APPENDIX B: STIMULUS FILE * TUTOR8XX.STL”

The tutor8xx.stl file consists of four sections:

1. Parameter Definitions: each of the M88 FLASH+PSD control registers has an I/O address (offset from
the CSIOP base address). The parameters make the stimulus file easier to read.

2. User-defined tasks: these are used to define and implement the microcontroller bus cycles. In each
task, the timing of the control signals and address or data bus should follow that of the microcontroller,
but they do not have to be exact; they just have to be to scale. The PSD Simulator will simulate a bus
cycle every time a read, write, or psen task is called.

3. Signal Initialization: you must specify the initial logic level of all the input signals before simulation. The
output signals that you want to simulate should be initialized to a high impedance state.

4. The stimulus inputs: here the stimulus inputs are needed to perform MCU read or write bus cycles to

access the Flash, EEPROM, SRAM or I/O ports. Inputs can also be generated to exercise the CPLD
functions.

[ITitle:tutor8XX stl

/I Function:Sinulation file for the MB8x3Fxx Tutori al
[/ Desi gned by: Dan Harris

/] Desi gn Dat e: 6-23-98

[/ Description:This fileis intended to be used in the PSDsiloslI| environment as a
/1 stimulus file for the MB8x3Fxx Tutorial. The idea of this file is not
/1 to show how the Veril og-HDL | anguage works, but rather the format of
/1 a .stl file, and howit applies to this tutorial exanple.

/1 The nain parts of this file are:

/1 * Parameter declarations which nake the file nore readabl e

I * Read, wite and "PSEN " bus cycle tasks for the 80C31

/1 * An area where the user may wish to add to the file in order to

/1 test nore functions

/1 * The actual stinulus of the design

/1

+++++++
+++

/'l Parameters declarations for the address offsets for the CSI OP address space
11

T T o NI SRS
+++

[lPort A

paraneter Port_ A Dir_Reg="h0906, Port A Ontl _Reg = h0902;
paraneter Port_A Dout_Reg='h0904, Port A Di n_Reg =" h0900;
paraneter Port_ A | MC="h090A, Port _A Drive_Sel = 'h0908;
paraneter Port_A En_CQut="h090C,

//Port B
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par anet er
par anet er
par anet er
par anet er

[IPort C
par anet er
par anet er
par anet er

[lPort D
par anet er
par anet er
par anet er

Port _B Dir_Reg="h0907, Port _B (ntl_Reg =" h0903;
Port B Dout _Reg="h0905, Port _B Di n_Reg =" h0901;

Port _B I MC="h090B, Port _B Drive_Sel = 'h0909;
Port _B _En_CQut =" h090D;
Port _C Dir_Reg="h0914, Port _C En_Qut = h091A;

Port C Dout Reg='h0912, Port _C Di n_Reg =" h0910;
Port C IMC="h0918,Port_C Drive_Sel = 'h0916;

Port D Dir_Reg="h0915, Port _D Drive_Sel = h0917;
Port D Dout Reg='h0913, Port _D Din_Reg = h0911;
Port D En_Qut =" h091B;

//Port AB OMCs

par amet er

/1 Port BC OMCs

par amet er

/1 Q her control

par anet er
par anet er
par anet er
par anet er

/1

Port _AB_OMC=" h0920, Port _AB_OMC Mask = ' h0922;

Port _BC_OMC=" h0921, Port _BC OMC Mask = ' h0923;
registers

FLASH Pr ot ect = h09C0, EEPROM Prot ect = ' h09C2;

PMVRO_Reg=" h09B0, PMVR1L_Reg =" h09B2;
PMVR2_Reg=" h09B4, JTAG En = ' h09C4;
Page Reg=' h09EO, VM Reg =' h09E2;

i B o S

+++

/1 Defining tasks to sinmulate 80C31 bus cycles (read, wite and psen bus cycl es).

/1 Note that the cycles are shortened for simnulation purposes,

but the

functionality
/!l remains the sane.

11

L S

+++

/1 The "wite task" inplenments the 80C31 wite bus cycle

task write;
i nput [15:0] addr_bus;
input [7:0] data_in;
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begi n

#20 ale = 1;//Latch the address I|ines

#20 adi o = addr_bus;//Read the valid address (adio defined in .top file)
#20 ale = 0;// Al e inactive

#20 adio[7:0] = data_in;//Wite operation

#40 w = 0;//Wite pul se

#100 wr = 1;//Wite ends

#10 adio[7:0] = Z8;//Z716 defined in .top file

end

endt ask

/1 The "read task" inplenents the 80C31 read bus cycle timng

task read;
i nput [15:0] addr_bus;

begi n

#20 ale = 1;//Latch the address |ines

#20 adi o = addr_bus;//Read the valid address

#20 ale = 0;//Al e inactive

#20 adi o[ 7: 0] = Z8;//Fl oat address bus (Z8 defined in .top)
#40 rd = 0;//Read pul se

#100 rd = 1;//Read ends

end

endt ask

/1 The "psen task" inplenments the 80C31 psen program fetch bus cycle

task psen
i nput [15:0] addr_bus;

begi n

#20 ale = 1;//Latch the address I|ines

#20 adi o = addr_bus;//Set-up the right address
#20 ale = 0;//Al e inactive

#20 adio[ 7:0] = Z8;//Fl oat address bus

#40 psen = 0;//Read pul se

#100 psen = 1;//Read ends

end
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endt ask

/1

++++++++
+++

/1 Define sone busses here to make the program easier to read.

/1

e s L 2 B M S S S S
+++

[ladrout is the |atched address output on Port A

reg [4:0] adrout;
reg Addr_Qut4, Addr_Qut 3, Addr_Qut2, Addr_CQutl, Addr_CQutO;
assign {Addr_Qut4, Addr_Qut3, Addr_Qut2, Addr_Qutl, Addr_Qut0} = adrout;

reg [3:0] measured_val ue;

reg Measured_Level 3, Measured_Level 2, Measured_Level 1, Measured_Level O;

assi gn {Measured_Level 3, Measured_Level 2, Measured_Level 1, Measured_Level 0} =
neasur ed_val ue;

reg [3:0] desired_val ue;

reg Desired_Level 3, Desired_Level 2, Desired_Level 1, Desired_Level O;
assign {Desired_Level 3, Desired_Level 2, Desired_Level 1, Desired_Level 0} =
desi red_val ue;

reg [3:0] PGA data;
reg PGA Din3, PGA Din2, PGA Dinl, PGA D nO;
assign {PGA D n3, PGA D n2, PGA D nl, PGA D n0} = PGA data;

reg [2:0] cntrl;
reg Control 2, Controll1, ControlO;
assign {Control 2, Controll, ControlQ0} = cntrl;

/1

++++++++++H+
+++

[/ Stimulus starting point

/1

/[l Initialize all the I/Ofirst. Then proceed with the rest of the simulation.
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11
e o B B B e s S S S S
+++

initial
begi n

/[llnitialize the signals first
w =1; rd = 1;

reset = 0;adio = 'h0000;
ale = 0; psen = 1;

adrout = Z8;
neasur ed_val ue = ' hQ;
desired _val ue = ' ho;

PGA dat a=Z4;cntrl = Z3;

Intrn = Z1; Start_Conv = Z1;

Trim = Z1; Boost = Z1;

JCEn = 1;

#100 reset = 1; // Take the PSD out of reset after 100ns

/W are now ready to do some configuration of the PSD

[/Port A configuration
[/ Configure Port A pins pad to pa0O to output the |atched address, and the rest
[lof the port will output control information in MCU I/ O node.

[IWiting "1F" to the Port A control register enables | atched address output on
/Ipins pad4d to pa0, and the rest of the port to output MU I/Q
wite(Port A Ontl _Reg, 'hif);

[IWiting "FF'" to Port A's direction register sets up Port A pins to be outputs.
wite(Port A Dir_Reg,'hff);

//Port B configuration

/1Since there is no | atched address output on Port B, and its control register
//defaults to MCU I/ O node output, only the direction register needs to be setup.
/IOnly pins pb3 to pbO will be outputting data, and the rest will be receiving
/1input

wite(Port B Dir_Reg,’'hof);

[ITAl of Port Cis output (wWith the exception of the Vsthy input
wite(Port _C Dir_Reg,'hfb);
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[l There is only one output on Port D (RTCcs/), so the direction register is
[lsetup as foll ows:
wite(Port_D Dir_Reg,’ h04);

/1Set up the nmask registers so that only the desired portion of the OMCs get
[/Iwitten. Only the desired value (MCELLAB[7:4]), and begin (MCELLBC7) can be
[Iwitten to.

wite(Port_AB OMC Mask, ' hOf);

wite(Port_BC OMC Mask, ' h7f);

//Wite the EEPROM segnent eesO, and the Flash segnent fsl
//then read the SRAM

write(’ h0020,’ h5a);//wite 5a to eesO
wite(’ h5A00," hab);//wite a5 to fsl
read ('hO7FE); //read the internal SRAM

// Wait, then initialize the gain to one and output the data on the pins
/1 pb2 to pbO.
#40 wite(Port_B Dout_Reg,’' h0l);

I/ Assume a small value for the output of the ADC since the gain is set
/1 to one
neasur ed_val ue=" h3;

/] Load 5 into the desired val ue register
wite(Port_AB OMC, 'h50);

/] Take the state machine out of the idle state and generate the ADC
/1 chip select.
#20 wite(Port _BC OMC, ' h80);

/1 Since the neasured value is | ess than the desired one, the gain would
/1 be boosted after the interrupt was generated (3 cycles after the start
/1 of the state machine). The MCU should increnent the gain by 1 at that
[l tine.

#400 wite(Port B Dout_Reg, 'h02);

#10 $finish;

J
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end

initial
begi n

/1 CGenerate a 10 Mz system cl ock used by the state machine, etc.
/] Note the time scale is set in the psdsoft.run file.

cl ki n=0;

forever #100 cl ki n=~cl ki n;

end //stinulus ends here

4
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APPENDIX C: LIST OF M88 FLASH+PSD SIMULATION SIGNALS

Figure 61 gives a list of signals from the Explorer that can be viewed using the Data Analyzer. This list is
based on the tutor8XX.abl file, and predefined signals. The list will vary depending on the names in your

.abl file, but most of the signals will be the same.

Figure 61. List of Simulation Signals
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Any of the above signals can be dragged to the Data Analyzer window for viewing. Once there, the signals
can be made into buses. For more information on the Explorer or Data Analyzer, see PSDsilosllI’s on-line

help, and the PSDsilos!ll User Manual.

68/83

J




AN1154 - APPLICATION NOTE

Table 3 contains all of the viewable predefined signal names, along with a brief description of each. The
conventions used in the table are:

= nrepresents a number
= X represents a letter
See the list above to determine which letters or numbers apply to the respective signal.

Table 3. Table C1-Predefined Signal Names and their Descriptions

Signal/Bus Name Description
VM VM register
adioh[15:8] Address/Data bus high byte
adiol[7:0] Address/Data bus low byte
ctrl_x Port x control register
data[7:0] Non-multiplexed 8-bit data bus
din_x Port x data in register
dirff_x Port x direction register
dout_x Port x data out register
drive_x Port x drive register
ecsdn External chip select output n
ee_boot_oe EEPROM output enable

ee_power_down

EEPROM power down signal

ee_protection[3:0]

PSD security and EEPROM sector protection

ee_ready_busy N

EEPROM ready/busy signal

ee_sdp_disable

EEPROM software data protection disable bit

ee_sdp_enable

EEPROM software data protection enable bit

ee_toggle EEPROM toggle signal
eesel_f EEPROM final chip select
enable_x Enable to port x driver

f_protection[7:0]

Flash sector protection register (read only)

flash_oe

Flash output enable

flash_polling

Flash data polling bit

flash_ready_busy

Flash ready/busy signal

flash_toggle Flash toggle bit
flsel_f Flash final chip select
jtag JTAG enable register
mask_mcab Mask AB register outputs
mask_mcbhc Mask BC register outputs
mcellabn Micro [ Cell AB noutput
mcellabn_clk Output Micro[ Cell AB n clock input

J
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Signal/Bus Name

Description

mcellabn_pr

Output Micro[ Cell AB n preset input

mcellabn_reg

Output Micro[ Cell AB n register input

mcellabn_re Output Micro [ Cell AB n reset input
mcellbcn Output Micro[ Cell BC n output

mcellben_clk Output Micro[ Cell BC n clock input

mcellbcn_pr Output Micro[ Cell BC n preset input

mcellbcn_reg

Output Micro[ Cell BC n register input

mcellbcn_re

Output Micro [ Cell BC n reset input

nib_xn

Product term control port x[7:4] or x[3:0] input Micro[ Cell

out_mcab[7:0]

Output registers for Micro[ Cell AB

out_mchbc[7:0]

Output registers for Micro [ Cell BC

pxn Port x, pin n
pxn_imc Port x, Input Micro[ Cell n
pxn_oe Port X, output enable n product term
pdn Power down signal
pgr7_0 Page register outputs
pmmrn Power management mode register n
pseln Port n peripheral select
rd_bsy PSD internal ready/busy status signal
sram_oe SRAM output enable signal
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APPENDIX D: DESIGN FILE FOR EPM7064S (U2 OF FIGURE 2)
-- Title:8XX Tutorial--D screte Solution

-- Function: Repl acenent for the programabl e | ogic portions of the MB8x3Fxx

-- Designed by:Dan Harris

-- Design date: 6/15/98

-- Description: This design shows what chip and | ogi c woul d be required to repl ace
t he

-- programmabl e | ogi ¢ portions of the MB813F1lx. This chip will be responsible
-- for the foll ow ng tasks:

-- * Latching the address generated by the 80C31 MCU.

-- * Decodi ng the address and generating internal/external chip selects.

-- * Storing control/status information in internal registers.

-- * Address translation for nmenory pageng.

-- * Interfacing to and controlling of the PGA in the Receiver circuit, and
the ADC

-- RTC, SRAM EEPROM FLASH, and MCU.

-- * Interfacing to a JTAG conpati ble port for |SP.

-- Convention: The tilde (~) is used throughout this design to indicate active | ow
si gnal s.

CONSTANT PAGE_REG ADDR = H'09E0";
CONSTANT VM REG ADDR = H'09E2";

CONSTANT MCU_| O OUT_ADDR = H'0902";
CONSTANT DESI RED_REG ADDR = H'0920";
CONSTANT GAIN REG ADDR = H'0901";
CONSTANT START _SI G ADDR = H'0921";

subdesi gn 8XXt ut or

(

-- The follow ng signals are generated by the MU (U1):
AD7..0]: BIDR;-- Miltiplexed address (|l ower byte)/data bus
A[15..8]: INPUT;-- Uoper byte of the addr bus

RD~ : INPUT;-- Read strobe
R~ . INPUT;-- Wite strobe
ALE : INPUT;-- addr latch enabl e signal

PSEN~ : I NPUT;-- Program store enable

-- System | evel inputs:
Reset ~: | NPUT;-- Systemreset
Cock : INPUT;-- System cl ock

-- The following signals are generated for the MCU (Ul):
AGC Interrupt~ QUTPUT;-- Interrupt the MCU when the desired and neasured signal
| evel s don't match
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Trim : COUTPUT;-- True when the neasured level is greater than the desired one
Boost : QUTPUT;-- Qpposite of Trim

-- The chip select output for the RTC (Wb):
RTC CS~: QUTPUT;

-- This signals are to/fromthe ADC (U7):

Start_Conversn: QUTPUT; -- Indicates when the ADC should start its anal og-to-
digital conversion
ADC Qut[3..0]: INPUT; -- The measured signal strength

-- The bus is used to set the gain on the PGA (part of U8)
PGA Din[2..0]: OUTPUT,;

-- The following are outputs to the external menories:

-- Chip selects

FLASH CS~: OUTPUT;

EEPROM CS~: OUTPUT;

SRAM CS~: QUTPUT;

-- Qutput enables

FLASH CE~: CQUTPUT;

EEPROM CE~: OUTPUT;

SRAM OCE~: QUTPUT;

-- Upper address bits

FLASH Al 16..14]: QUTPUT;-- M5 addr bits for the 128K FLASH - for segnentation
EEPROM Al 14..13]: QUTPUT; -- M addr bits for the 32K EEPROM - for segnentation

-- Latched/ demrul ti pl exed address out put
Addr_Qut[7..0]: QUTPUT;-- outputs to the external nenories

-- Control Qutput for MU I/ O node
Control [2..0]: QUTPUT;

)
VAR ABLE
AD7..0]: TR ;-- Needed to drive the data output onto the data bus

la[7..0] : LATCH -- Mist demux | ower byte of addr

page _reg[7..0]: DFFE;-- Page register

vmreg[7..0]: DFFE, -- Used for nmenory mapping in conbi ned nenory space node
desired reg[3..0]: DFFE;-- Register to store the desired signal |evel (set by the

MY

gain_reg[2..0]: DFFE;, -- Register to store the gain level (set by the MU
begi n_conparrison: DFFE, -- takes state machine out of idle state (s0)
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cntrl _port_reg[2..0]: DFFE;-- MU I/O node control register
addr[15..0]: NODE;-- Denultipl exed addr

fs[7..0] : NODE; -- FLASH segnent enabl e signals

ees[3..0] : NODE;, -- EEPROM segnent enabl e signals

swap : NODE;, -- bit 7 of the page register

enabl e_data half: NODE;-- bit 6 of the page register
neasured[ 3..0]: NODE;-- Qutput fromthe ADC

desired[3..0]: NODE;-- Input fromthe MU

neqd : NODE;-- True when the neasured val ue equal s the desired one
sm : MACH NE WTH STATES (s0, s1, s2, s3);

BEG N

-- Right now, there is nothing to output to the MU on the A/D |ines
ANDO] = GN\Db

-- Latch in the addr[]
la[] = AO];
la[].ena = ALE;
addr[7..0] =1la[];
addr[15..8] = A ];
Addr_Qut[] = la[];

begi n_conparri son = A D7;

begi n_conparrison. cl k = d ock;

begi n_conparrison.clrn = Reset ~;

begi n_conparrison.ena = ' WR~ & (addr[] == START_SI G ADDR);

desired reg[] = AD7..4];

desired reg[].clk = d ock;

desired reg[].clrn = Reset ~;

desired reg[].ena = ' WR~ & (addr[] == DESI RED REG ADDR);

gain_reg[] = AD2..0];

gain_reg[].clk = d ock;

gain_reg[].clrn = Reset~;

gain_reg[].ena = 'WR~ & (addr[] == GAI N REG ADDR);

cntrl _port _reg[] = AD2..0];

cntrl _port_reg[].clk = d ock;

cntrl_port _reg[].clrn = Reset~;

cntrl_port _reg[].ena = !WR~ & (addr[] == MCU_| O QUT_ADDR);
page_reg[] = A DO];
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page_reg[].clk = O ock;
page_reg[].clrn = Reset~;
page_reg[].ena = | WR- & (addr[] == PAGE REG ADDR);

vmreg[] = AD];

vmreg[].clk = O ock;

vmreg[].clrn = Reset~;

vmreg[].ena = 'WR~ & (addr[] == VM REG ADDR);

measured[] = ADC Qut[];
desired[] = desired_reg[];
PGA Din[] gain_reg[];
Control [] cntrl _port _reg[];

- Menory Section
swap = page_reg7;
enabl e_data hal f = page_reg6;

fsO = ((addr[] >= H'8000") & (addr[] <= H'BFFF") & (page_reg[] == 3) & !swap)
# ((addr[] >= H'0000") & (addr[] <= H'3FFF"') & swap);

fsl = (addr[] >= H'4000") & (addr[] <= H'7FFF");

fs2 = (addr[] >= H'8000") & (addr[] <= H'BFFF') & (page_reg[] == 0);

fs3 = (addr[] >= H'C000") & (addr[] <= H'FFFF') & (page_reg[] == 0);

fs4 = (addr[] >= H'8000") & (addr[] <= H'BFFF') & (page_reg[] == 1);

fsb = (addr[] >= H'C000") & (addr[] <= H'FFFF') & (page_reg[] == 1);

fs6 = (addr[] >= H'8000") & (addr[] <= H'BFFF"') & (page_reg[] == 2);

fs7 = (addr[] >= H'C000") & (addr[] <= H'FFFF") & (page_reg[] == 2);

eesO = ((addr[] >= H'0000") & (addr[] <= H'1FFF"') & !swap)

# ((addr[] >= H'8000") & (addr[] <= H'9FFF") & swap & !enabl e data_hal f);
eesl = ((addr[] >= H'2000") & (addr[] <= H'3FFF") & !swap)

# ((addr[] >= H'A000") & (addr[] <= H'BFFF"') & swap & !enabl e data_hal f);
ees2 = (addr[] >= H'Q000") & (addr[] <= H'DFFF") & swap & enabl e_data_hal f;
ees3 = (addr[] >= H'EO00") & (addr[] <= H'FFFF") & swap & enabl e_data_hal f;

-- FLASH upper 3 and EEPROM upper 2 address bit encoding

FLASH A16 = fs7 # fs6 # fsb # fs4,
FLASH A15 = fs7 # fs6 # fs3 # fs2;
FLASH A14 = fs7 # fs5 # fs3 # fsl,
EEPROM Al4 = ees3 # ees?;
EEPROM Al13 = ees3 # eesl,;

-- Chip Selects and Qutput Enables

J
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-- SRAM has hi ghest priority, followed by EEPROM and then FLASH

IFLASH CS~ = (fsO # fsl # fs2 # fs3 # fs4 # fs5 # fs6 # fs7) & (EEPROM CS~ #

SRAM CS~) ;
| EEPROM CS~ = (eesO # eesl # ees2 # ees3) & SRAM CS-;
I'SRAM CS~ = ((addr[] >= H'0100") & (addr[] <= H'O8FF"));

I RTC CS~ = ((addr[] >= H'0A00") & (addr[] <= H'OALF"));
I SRAM CE~ = ! (I RD~ # (! PSEN~ & vm reg0));

| EEPROM OE~ = ! ((! PSEN- & vmregl) # (vmreg3 & !RD-));
I FLASH CE~ = ! ((! PSEN- & vmreg2) # (vmregd & !RD-));

-- Conparator /0O

Trim= (measured[] > desired[]);
meqd = (neasured[] == desired[]);
Boost = ! Trim & ! neqd,

-- State Machi ne
smcl k = d ock;
smreset = ! Reset~;

CASE sm IS
VWHEN sO =>
Start_Conversn = G\D,
ACC I nterrupt~ = VCGC
I F (begi n_conparrison) THEN
sm = sl
ELSE
sm = sO0;
END | F;

WHEN s1 =>
Start _Conversn
sm= s2;

WHEN s2 =>
Start _Conversn
sm = S3;

WHEN s3 =>

VCC,

9
o,

I'ACC Interrupt~ = Trim# Boost;-- Interrupt when Measured not equal

Desired
sm = sO0;
END CASE;

END,

573
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APPENDIX E: COMPARING THE DISCRETE AND INTEGRATED SOLUTIONS

This appendix compares the two circuits of Figure 2 and Figure 3 in the following categories:
m Cost

= Average Current Usage

» Board Space Usage

= Time to market

(Only the major ICs are compared here.)

COST
The 150 ns M8813F1x in the PLCC package can be purchased at a significantly lower price than the total
cost of the individual EEPROM, Flash, SRAM, and CPLD devices.

AVERAGE CURRENT USAGE

The M88x3Fxx would typically use 4.29 mA according to the “Example of M88x3Fxx Typical Power
Calculation at V¢ =5.0 V" in the "AC and DC Parameters” sections of the M88 FLASH+PSD Data Sheet.
If we take the total average current of the devices in the discrete solution, we get 32.4 mA (with the
EPM7064S not in turbo mode). This shows that the discrete solution uses 755% more current than the
PLD.

BOARD SPACE USAGE

The M8813F1x in the PLCC package takes up 400 mm?Z. The chips that make up the discrete solution take
up a combined 1493 mm?2. That equates to 373% more board space. (All calculations have been based
on PLCC packages.) This calculation does not reflect the extra board space, complexity, and noise
associated with routing the signals in the discrete solution.

TIME TO MARKET
The time to market will be reduced significantly for many reasons:
= The integrated PSD solution involves one complex integrated circuit, not four.

= There are templates and predefined routines that, when used in conjunction with our user-friendly
PSDsoft, help you with every step of your design process.

= Issues related to concurrent memory, memory mapping, and MCU assisted ISP are simplified.

m C code is generated for you.

m  The JTAG interface is one of the greatest benefits and time savers. It allows you to program, configure,
and test the entire PSD, and leave it soldered to the board the whole time.

= There are just fewer places to go wrong, and fewer things to debug when you have this level of
integration.

J
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APPENDIX F: SYSTEM MEMORY MAP AND UART ISP

INTRODUCTION

A system memory map was developed for this tutorial to take full advantage of the memory available in
the M8813F1x, and to expand beyond the 64 KByte address space limitation of the 8031 MCU. This
memory map facilitates the downloading of firmware from a host computer to the Flash memory in the PSD
using the 8031 UART. The 8031 boots from the PSD EEPROM, concurrently downloads to PSD Flash
memory, and then 8031 execution jumps from EEPROM to Flash memory. After this jump, the EEPROM
in the boot area address space is replaced with Flash memory by a special register within the PSD (the
VM Register). After that, the entire Flash memory is available to the 8031.

This system memory map also allows the concurrent downloading of boot code into the PSD EEPROM
while executing code out of PSD Flash memory. This is not possible in non-PSD systems that use PROM
for boot code.

The total memory available to the 8031 as defined in this system is:

= 128 KBytes Flash

= 16 KBytes EEPROM for boot code

= 16 KBytes EEPROM for data storage

m 2 KBytes battery-backed SRAM (in addition to the 256 bytes SRAM resident on the 8031)

SYSTEM MEMORY MAP

The system memory map is shown in Figure 62, Figure 63, Figure 64, and Figure 65. The labels FSx and
EESx are the names of internal memory segments within the M8813F1x device. FSx represents 16 Kbyte
Flash segments, EESx represents 8 Kbyte EEPROM segments.

In this design, paging is used because the system contains more memory than the 8031 can address
linearly. The M8813F1x facilitates paging by using a page register, which the 8031 can access. Because
paging is used, a common memory area is needed for firmware routines that must be accessible
regardless of what page the MCU is executing from. This common area resides in the lower half of each
memory page in program space (shown in Figure 62, Figure 63, Figure 64, and Figure 65). It should
contain routines that handle initialization, interrupts, implement page switching, and drive physical
devices. It is also used to keep critical data space items available at all times. For example, in this design,
the PSD control registers, I/0, and system SRAM for the stack and global variables are available on any
memory page (see Figure 62, Figure 63, Figure 64, and Figure 65).

There are two fundamental modes of operation: one is boot/download mode, and the other is normal
operation. Figure 62, Figure 63, Figure 64, and Figure 65 show the memory map during the transition from
boot/download mode to normal operation mode.

Figure 16 represents the memory map at power-on (boot). The system boots up from EEPROM, and then
facilitate a download to the main Flash memory (if needed) using the 8031 UART. At this point, all of the
PSD Flash memory is in the 8031 “data space” and all of the EEPROM is in the 8031 “program space”.
This is due to the “MCU Bus Configuration” that was performed in step 2 of the section entitled “PSDsoft
Configuration” (on page 20), and shown in Figure 16. This step of the configuration automatically sets the
VM register to 12h. Please refer to the M88 FLASH+PSD Data Sheet for information on the VM register
settings.

It is very important to note that the PSD Configuration utility initialises the VM register (located in the
CSIOP space at offset E2h), and that it can only be changed by the MCU after it has booted. After the
Flash has been programmed or validated, the Flash memory is moved from the 8031 data space to the
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8031 program space by the MCU writing 06h to the VM register (while still executing out of PSD
EEPROM).

Figure 62 represents the memory map after the Flash memory has been moved to the program space.
This is an intermediate step that is a result of writing to the VM register.

Next, the 8031 execution jumps from PSD EEPROM to PSD Flash memory. While executing from PSD
Flash memory, the 8031 sets a bit in the PSD page register that we call “SWAP”. The EEPROM that the
MCU booted from, during power-up, is replaced with Flash memory that contains application vectors and
code, as shown in Figure 64. The transition between the two maps of Figure 63 and Figure 64 is under
the control of the 8031 by setting the “SWAP” bit inside the PSD (defined in the PSDabel, tutor8XX.abl,
file). Again, the state of the memory map, shown in Figure 64, is an intermediate step.

Individual bits within the 8-bit PSD page register may be used for functions other than memory page
definition. For example, in this tutorial, two of the eight PSD page register bits are use to define four
memory pages, and one of the page register bits is used as the “SWAP” bit, as described above.

Finally, while executing from the PSD Flash memory, the 8031 must write OCh to the VM register in the
PSD to move the PSD EEPROM from the 8031 program space to the 8031 data space. This finalizes the
memory map, as shown in Figure 65. Now, all 128 KBytes of PSD Flash memory are in the program space,
with 32 KBytes in a common area and 96 KBytes spread across three memory pages. Also, the EEPROM
is now in the data space, and is accessible from any memory page. Notice that two more PSD EEPROM
segments (EES2 and EES3) appear in Figure 65. These two segments are for general data use while the
other two EEPROM segments (EESO and EES1) contain the 8031 power-on boot code.

Now that the system memory map looks like that of Figure 65, another feature becomes available. Besides
the mechanisms mentioned, there is one more memory mapping control bit used in this tutorial design.
This bit, ‘ENABLE_DATA_HALF", is another PSD page register bit used to protect the boot code in EESO
and EES1 from inadvertent writes. At the same time, it enables the other half of the EEPROM (EES2 and
EES3) to be accessed for general data. For example, to update the boot code in EESO and EES1 with
new code downloaded over the UART, the 8031 would leave ENABLE_DATA_HALF at logic zero,
perform the update by writing to EESO and EES1, then set ENABLE_DATA_ HALF to logic one. Now the
new boot code is inaccessible (protected while not booting), and the data half of EEPROM is accessible.

Figure 62. System Memory Map for 8031-M8813F1x, boot/download
POWER-UP (VM Register = 12h)

PROGRAM SPACE DATA SPACE
(PSENY (RDY)

PAGE X PAGE 0 PAGE 1 PAGE 2 PAGE 3

FFFF FFFF

8000

COMMON

4000  MEMORY
ACROSS ALL
DATA PAGES

HING MAPPED

1000

SYSTEM RAM & I/0 SYSTEM RAM & /O SYSTEM RAM & 110 SYSTEMRAM&IO | o

|
|
|
|
|
|
i Fs2 Fs4 FS6 FSO
|
|
|
|
|
|

Al03300

78/83 K’7




AN1154 - APPLICATION NOTE

Figure 63. System Mem Map for 8031-M8813F1x, move Flash to program space
WRITE 06h TO THE VM REGISTER
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Figure 64. System Memory Map for 8031-M8813F1x, swap boot EEPROM with Flash segment
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Figure 65. Final Sys Mem Map for 8031-M8813F1x, move EEPROM to data space
WRITE OCh TO THE VM REGISTER
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CODE PARTITIONING IN THE FLASH MEMORY PAGES

Ultimately, the MCU will be executing from Flash memory since the EEPROM is used for boot-up and ISP
in this design. Let us assume that we have 128 KBytes of program space in Flash memory, as shown in
Figure 65. The 128 KBytes of code resides in four areas: 32 KBytes in the common area (FSO and FS1,
accessible from any page), 32 KBytes on page zero (FS2 and FS3), 32 KBytes on page one (FS4 and
FS5), and 32 KBytes on page two (FS6 and FS7).

If the 8031 never leaves page zero while executing, it can access 64 KBytes of Flash memory in FSO
through FS3 as well as all of the SRAM and I/O. If the 8031 execution jumps to Flash memory on pages
one or two from a call on the upper half of page zero (FS2 or FS3), care must be taken to leave a path to
return to page zero again. However, if the call to page one or two is from a routine in the lower half of page
zero (the common area, FSO or FS1), there is no problem returning from the call.

When placing code in the Flash memory on the upper half of pages zero, one, or two, the software
designer must break tasks into logical groups. These groups should not need to access code frequently
on other pages. (Most software can be splitin this manner and is a result of a good modular design.) Since
system SRAM is available on any page, firmware routines that reside on different pages may pass data
using global variables or the stack. The designer can create page-switching algorithms to jump between
tasks on different pages. There are many ways to implement a paging scheme: one method involves the
use of a table that contains addresses and page numbers of all program tasks, which may be called from
page to page. The table and algorithms must reside in the portion of Flash memory that is located in the
common area. This provides a very clean paging solution, which may be implemented using a high-level
compiler. (The compiler from Keil supports this directly, and creates the tables for you.) The only penalty
when using this method is the overhead experienced when switching from one page to another.

For this tutorial design, five different files from an MCU cross-compiler and linker are used to program the
NVM sections of the M8813F1x. These are dummy files with no code in them, but are present to illustrate
the merging of MCU firmware with the PSD configuration during the Address Translate operation. If this
were a real design, the file common.hex would contain all of the common functions and interrupt vectors,
and would be programmed into FSO/FS1. Three more files from the MCU linker, page _0.hex, page_1.hex,
and page_2.hex would contain the partitioned code described above. As such, these three files would be
programmed into segments FS2/FS3, FS4/FS5, and FS6/FS7, respectively. Finally, the file boot.hex,
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containing the power-up boot code and programming algorithms for Flash memory, would be programmed
into EESO/EESL.

START-UP SEQUENCES, UART DOWNLOADS

Let us assume that a PC or lap-top is to be used as a host to download firmware to this embedded system
over an RS-232 UART channel (instead of JTAG). These download actions can program the main Flash
memory for the very first time; can update the main Flash after it has been programmed once; or can
update the boot code after being programmed for the first time by a device programmer or JTAG link.
There are six valid boot-up arrangements (labelled respectively: a, b, c, d, e and f) that must be handled
by the system at power-up (reset). The default setting of the VM register at power-up places the main
Flash memory in the data space and the EEPROM in the program space. Please refer to the memory
maps in Figure 62, Figure 63, Figure 64, and Figure 65.

a. RS-232 cable not attached, main Flash valid
8031 action:

Boot from EESO/ EES1

Run a checksum on the Fl ash nenory

Check the UART for a pending host downl oad request of main Flash (Figure 62)

Set a bit inthe PSDVMregister to put main Fl ash i nto programspace (Fi gure 63)

Set the SWAP bit in PSD, which swaps EESO/EES1 with FSO (Figure 64)

Set a bit inthe PSD VMregister to put the EEPROMinto data space (Figure 65)
Now, the systemis in normal operating node. More 8031 action:

Check the UART for a host downl oad request of boot nenory

Set the ENABLE DATA HALF bit in the PSD if no boot downl oad request exists
Normal application code can now be executed frommain Fl ash nenory.

b. RS-232 cable attached, main Flash valid, no download demands from host
Action: same as step "a.", above.

c. RS-232 cable attached, main Flash valid, download of main Flash is demanded by host
8031 action:

Boot s from EESO/ EES1

Run a checksum on the Fl ash nmenory

Check the UART for a pending host downl oad request of main Flash (Figure 62)

Programthe nain Flash menmory with data fromthe UART

Set a bit inthe PSDVMregister to put nmain Flash i nto programspace (Fi gure 63)

Set the SWAP bit in PSD, which swaps EESO/EES1 with FSO (Fi gure 64)

Set a bit inthe PSD VMregister to put the EEPROMinto data space (Figure 65)
Now, the systemis in normal operating node. Mre 8031 action:

Check the UART for a host downl oad request of boot nenory

Set the ENABLE DATA HALF bit in the PSD if no boot downl oad request exists
Norrmal application code can now be executed frommain Fl ash nenory.

J
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d. RS-232 cable not attached, main Flash is blank or invalid
8031 action:

Boot from EESO/ EES1

Run a checksum on the Flash nenory

Check the UART for a pending host downl oad request of main Flash (Figure 62)
Wait until any UART traffic is present (Figure 62)

e. RS-232 cable attached, main Flash is blank or invalid
8031 acti on:

Boot from EESO/ EES1

Run a checksum on the Fl ash nmenory

Check the UART for a pending host downl oad request of main Flash (Figure 62)

Programthe nain Flash menmory with data fromthe UART

Set a bit inthe PSDVMregister to put nmain Flash i nto programspace (Figure 63)

Set the SWAP bit in PSD, which swaps EESO/EES1 with FSO (Figure 64)

Set a bit inthe PSD VMregister to put the EEPROMinto data space (Figure 65)
Now, the systemis in normal operating node. More 8031 action:

Check the UART for a host downl oad request of boot nenory

Set the ENABLE DATA HALF bit in the PSD if no boot downl oad request exists
Normal application code can now be executed from main Fl ash nenory.

f. RS-232 cable attached, main Flash is valid, system requests a download of boot memory
8031 action:

Boot from EESO/ EES1

Run a checksum on the Flash nenory

Check the UART for a pending host downl oad request of main Flash (Figure 62)

Set a bit inthe PSDVMregister to put main Fl ash i nto programspace (Fi gure 63)

Set the SWAP bit in PSD, which swaps EESO/EES1 with FSO (Figure 64)

Set a bit inthe PSD VMregister to put the EEPROMinto data space (Figure 65)
Now, the systemis in nornal operating node. More 8031 action:

Check the UART for a host downl oad request of boot nenory

Programt he EEPROM boot nenory in EESO and EES1 with data fromthe UART

Run a checksum on EESO and EES1

Set the ENABLE _DATA HALF bit in the PSD

to protect the boot code in EESO and EES1 fromi nadvertent wites

Enabl e data access of EES2 and EES3
Norral application code can now be executed fromnmain Fl ash nmenory.
For of any of these host UART download options, it is assumed that the normal boot (EESO/EES1) area
is programmed the very first time by a device programmer before the PSD is installed on the circuit card
or by the JTAG interface while the PSD is in-system.

J
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For current information on M88 FLASH+PSD products, please consult our pages on the world wide web:
www.st.com/flashpsd

If you have any questions or suggestions concerning the matters raised in this document, please send
them to the following electronic mail addresses:

apps.flashpsd@st.com (for application support)
ask.memory@st.com (for general enquiries)

Please remember to include your name, company, location, telephone number and fax number.

Information furnished is believed to be accurate and reliable. However, STMicroelectronics assumes no responsibility for the consequences
of use of such information nor for any infringement of patents or other rights of third parties which may result from its use. No license is granted
by implication or otherwise under any patent or patent rights of STMicroelectronics. Specifications mentioned in this publication are subject
to change without notice. This publication supersedes and replaces all information previously supplied. STMicroelectronics products are not
authorized for use as critical components in life support devices or systems without express written approval of STMicroelectronics.

© 2000 STMicroelectronics - All Rights Reserved
The ST logo is a registered trademark of STMicroelectronics.
All other names are the property of their respective owners.
STMicroelectronics GROUP OF COMPANIES

Australia - Brazil - China - Finland - France - Germany - Hong Kong - India - Italy - Japan - Malaysia - Malta - Morocco - Singapore - Spain -
Sweden - Switzerland - United Kingdom - U.S.A.
http://www.st.com
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